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 (Course on Computer Concept) 

500+ MCQs in Hindi
1. Fundamental of Computer : 100 MCQs
2. Operating System: Windows/ Linux : 100 MCQs
3. Word Processing (Libre Office Write) : 50 MCQs
4. Spreadsheet Software (Libre Office Calc) : 50 MCQs
5. Presentation Software (Libre Office Impress) : 50 MCQs
6. Introduction to Internet, WWW and Web Services : 100 MCQs
7. E-Mail, Social Networking and e-Governance Services: : 100 MCQs
8. Digital Financial Tools and Applications: : 100 MCQs
9. Overview of Future skills and Cyber Security : 100 MCQs               Total : 750 MCQs 
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1. Fundamental of Computer : 100 MCQs
 SECTION–1: Computer Evolution, Development, Generations & Father (10 MCQs)🔹

Q1.           कं प्यूटर की पहली पीढ़ी में किस तकनीक का उपयोग हुआ था?
Which technology was used in first generation computers?
A) Transistor
B) Vacuum Tube
C) IC
D) Microprocessor

Q2.          कं प्यूटर की दू सरी पीढ़ी किस वर्ष के आसपास शुरू हुई?
Second generation of computers started around?
A) 1940
B) 1950
C) 1956
D) 1970
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Q3.        तीसरी पीढ़ी के कं प्यूटरों  में क्या प्रयोग हुआ?
What was used in third generation computers?
A) Vacuum Tube
B) Transistor
C) Integrated Circuit
D) AI

Q4.         चौथी पीढ़ी के कं प्यूटरों  की मुख्य पहचान क्या है?
Main feature of fourth generation computers is?
A) IC
B) Microprocessor
C) Vacuum Tube
D) Punch Card
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Q5.        कं प्यूटर की पाँचवीं  पीढ़ी किस पर आधारित है?
Fifth generation computers are based on?
A) Machine Language
B) Artificial Intelligence
C) Transistor
D) Assembly Language

Q6.    कं प्यूटर के जनक (Father of Computer)  कौन हैं?
Who is known as the father of computer?
A) Alan Turing
B) Charles Babbage
C) John Von Neumann
D) Bill Gates
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Q7. ENIAC     किस प्रकार का कं प्यूटर था?
ENIAC was a type of?
A) Analog
B) Hybrid
C) Digital
D) Supercomputer

Q8. Analytical Engine    किसने प्रस्तावित किया था?
Who proposed Analytical Engine?
A) Newton
B) Charles Babbage
C) Turing
D) Von Neumann
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Q9.            पहली पीढ़ी के कं प्यूटर बहुत अधिक किस चीज की खपत करते थे?
First generation computers consumed high?
A) Memory
B) Electricity
C) Software
D) Data

Q10.       कं प्यूटर का विकास मुख्यतः किस कारण हुआ?
Computer evolution mainly occurred due to?
A) Entertainment
B) Business need
C) Data processing requirement
D) Gaming

 SECTION–2: Computer Parts, Types, Input & Output Devices (10 MCQs)🔹
Q11. CPU     का पूरा नाम क्या है?
Full form of CPU is?
A) Central Process Unit
B) Central Processing Unit
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C) Control Processing Unit
D) Core Processing Unit

Q12.       कं प्यूटर का मस्तिष्क किसे कहा जाता है?
Which is called the brain of computer?
A) RAM
B) Hard Disk
C) CPU
D) Monitor

Q13.     निम्न में से कौन Input Device है?
Which is an input device?
A) Printer
B) Monitor
C) Keyboard
D) Speaker

Q14.    निम्न में से Output Device   कौन सा है?
Which is an output device?
A) Mouse
B) Scanner
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C) Printer
D) Joystick

Q15. RAM     किस प्रकार की मेमोरी है?
RAM is which type of memory?
A) Permanent
B) Temporary
C) Secondary
D) Offline

Q16.     निम्न में से कौन Storage Device है?
Which is a storage device?
A) Keyboard
B) Monitor
C) Hard Disk
D) Webcam

Q17.        सुपर कं प्यूटर का उपयोग किस लिए होता है?
Supercomputer is used for?
A) Typing
B) Weather Forecast
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C) Drawing
D) Browsing

Q18.      टैबलेट किस प्रकार का कं प्यूटर है?
Tablet is which type of computer?
A) Super
B) Mainframe
C) Handheld
D) Hybrid

Q19. Scanner      का उपयोग किस लिए होता है?
Scanner is used to?
A) Print data
B) Store data
C) Convert hard copy to soft copy
D) Send email

Q20. UPS    का कार्य क्या है?
Function of UPS is?
A) Increase speed
B) Power backup
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C) Store data
D) Process data

 SECTION–3: Software, Hardware & Types (10 MCQs)🔹
Q21.   हार्डवेयर क्या है?
What is hardware?
A) Programs
B) Physical components
C) Data
D) Instructions

Q22.      सॉफ्टवेयर का उदाहरण कौन सा है?
Which is an example of software?
A) Monitor
B) CPU
C) Windows
D) Keyboard

Q23.     सिस्टम सॉफ्टवेयर का उदाहरण है?
Example of system software is?
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A) MS Word
B) Photoshop
C) Operating System
D) Browser

Q24. Application software      का उपयोग किस लिए होता है?
Application software is used for?
A) System control
B) User tasks
C) Hardware repair
D) Booting

Q25. Linux  क्या है?
Linux is a?
A) Hardware
B) Application
C) Operating System
D) Device

Q26.    फर्मवेयर क्या होता है?
Firmware is?
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A) Software in ROM
B) Application software
C) Hardware device
D) Virus

Q27. Open source software   का अर्थ है?
Open source software means?
A) Paid
B) Restricted
C) Source code available
D) Trial

Q28.     निम्न में से कौन Utility Software है?
Which is utility software?
A) Antivirus
B) MS Excel
C) Browser
D) Compiler

Q29. Compiler    का कार्य क्या है?
Function of compiler is?
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A) Execute program
B) Translate language
C) Store data
D) Print

Q30. Software      बिना किसके काम नहीं  कर सकता?
Software cannot work without?
A) User
B) Hardware
C) Internet
D) Data

 SECTION–4: Technology, Networks, Cable & Communication (10 MCQs)🔹
Q31. LAN     का पूरा नाम क्या है?
Full form of LAN is?
A) Large Area Network
B) Local Area Network
C) Logical Area Network
D) Low Area Network
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Q32. WAN       का उपयोग किस स्तर पर होता है?
WAN is used at which level?
A) Room
B) Building
C) City
D) Global

Q33.         नेटवर्क में डाटा किस रूप में भेजा जाता है?
Data is transmitted in network as?
A) File
B) Packet
C) Folder
D) Page

Q34. Coaxial cable     का उपयोग किसमें होता है?
Coaxial cable is used in?
A) Telephone
B) Cable TV
C) Power supply
D) Printer
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Q35.       सबसे तेज नेटवर्क के बल कौन सी है?
Fastest network cable is?
A) Twisted Pair
B) Coaxial
C) Optical Fiber
D) USB

Q36. Modem    का कार्य क्या है?
Function of modem is?
A) Store data
B) Convert digital to analog
C) Print data
D) Process data

Q37. Wi-Fi     किस प्रकार की तकनीक है?
Wi-Fi is which technology?
A) Wired
B) Wireless
C) Optical
D) Mechanical
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Q38. Bluetooth      का उपयोग किस लिए होता है?
Bluetooth is used for?
A) Long distance
B) Short range communication
C) Satellite
D) Fiber

Q39.   नेटवर्क में HUB    का कार्य क्या है?
Function of HUB is?
A) Route data
B) Connect devices
C) Encrypt data
D) Store data

Q40. Communication   का अर्थ है?
Communication means?
A) Storage
B) Processing
C) Exchange of information
D) Execution
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 SECTION–5: Innovation & Current Affairs of Information Technology (10 MCQs)🔹
Q41. AI     का पूरा नाम क्या है?
Full form of AI is?
A) Automatic Internet
B) Artificial Intelligence
C) Advanced Internet
D) Applied Information

Q42. ChatGPT     किस तकनीक पर आधारित है?
ChatGPT is based on?
A) IoT
B) AI
C) Blockchain
D) Cloud

Q43. Cloud Computing     का मुख्य लाभ क्या है?
Main benefit of cloud computing is?
A) High cost
B) Data loss
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C) Anywhere access
D) Virus

Q44. Blockchain      का उपयोग मुख्यतः किसमें होता है?
Blockchain is mainly used in?
A) Gaming
B) Cryptocurrency
C) Printing
D) Typing

Q45.       डिजिटल इंडिया अभियान किस वर्ष शुरू हुआ?
Digital India mission started in?
A) 2012
B) 2014
C) 2015
D) 2018

Q46. 5G    तकनीक किससे संबंधित है?
5G technology is related to?
A) Hardware
B) Network speed
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C) Storage
D) Software

Q47. IoT     का पूरा नाम क्या है?
Full form of IoT is?
A) Internet of Technology
B) Internet of Things
C) Input of Things
D) Information of Technology

Q48.      साइबर सुरक्षा का उद्देश्य क्या है?
Purpose of cyber security is?
A) Data sharing
B) Data protection
C) Data deletion
D) Data formatting

Q49. UPI   किससे संबंधित है?
UPI is related to?
A) Education
B) Banking



 MARATHON CLASS FOR CCC EXAM & OTHER                                                                                                                YORHELP EDUCATION

C) Gaming
D) Networking

Q50. Green Technology    का उद्देश्य क्या है?
Purpose of green technology is?
A) Fast computing
B) Environment protection
C) Data security
D) Gaming

 SECTION–6: Booting, Deadlock, Surge Protector, UPS, Processor (10 MCQs)🔹
Q51.         कं प्यूटर को प्रारंभ करने की प्रक्रिया क्या कहलाती है?
The process of starting a computer is called?
A) Processing
B) Booting
C) Loading
D) Executing

Q52. Warm Boot    का अर्थ क्या है?
Warm boot means?
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A) Power off start
B) Restart computer
C) Cold environment
D) Virus scan

Q53. Deadlock     किस स्थिति को कहते हैं?
Deadlock is a condition when?
A) CPU stops
B) Programs wait for each other
C) Memory full
D) Power failure

Q54. Surge Protector       का उपयोग किस लिए किया जाता है?
Surge protector is used to?
A) Increase speed
B) Save power
C) Protect from voltage fluctuation
D) Store data

Q55. UPS     का पूरा नाम क्या है?
Full form of UPS is?
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A) Universal Power System
B) Uninterrupted Power Supply
C) Uninterruptible Power Supply
D) Unified Power Source

Q56. UPS     का मुख्य कार्य क्या है?
Main function of UPS is?
A) Cooling system
B) Power backup
C) Data storage
D) Virus protection

Q57. Processor    का कार्य क्या है?
Function of processor is?
A) Input
B) Output
C) Processing
D) Storage

Q58. CPU      में कितने मुख्य भाग होते हैं?
CPU mainly consists of how many parts?
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A) One
B) Two
C) Three
D) Four

Q59. ALU    का कार्य क्या है?
Function of ALU is?
A) Storage
B) Logic & arithmetic operations
C) Control
D) Input

Q60. Control Unit    का कार्य क्या है?
Function of Control Unit is?
A) Calculation
B) Data storage
C) Instruction control
D) Printing
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 SECTION–7: Language Translator, HLL, MLL, LLL, System & Application Software (10 MCQs)🔹

Q61.       कं प्यूटर किस भाषा को सीधे समझता है?
Which language is directly understood by computer?
A) HLL
B) Assembly
C) Machine Language
D) Python

Q62. High Level Language   का उदाहरण है?
Example of HLL is?
A) Binary
B) C++
C) Assembly
D) Machine code

Q63. Machine Language     किस रूप में होती है?
Machine language is in form of?
A) Alphabet
B) Symbols
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C) Binary (0,1)
D) Decimal

Q64. Assembly Language     किस स्तर की भाषा है?
Assembly language is which level language?
A) High
B) Low
C) Middle
D) Very high

Q65. Assembler    का कार्य क्या है?
Function of assembler is?
A) Translate HLL
B) Translate Assembly
C) Execute program
D) Store data

Q66. Compiler    का कार्य क्या है?
Compiler is used to?
A) Convert HLL to machine language
B) Print program
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C) Execute file
D) Scan virus

Q67. Interpreter    की विशेषता क्या है?
Feature of interpreter is?
A) Line by line translation
B) Fast execution
C) No error display
D) Hardware control

Q68. System Software   का उदाहरण है?
Example of system software is?
A) MS Word
B) Linux
C) Photoshop
D) Excel

Q69. Application Software      का उपयोग किस लिए होता है?
Application software is used for?
A) Hardware control
B) User specific tasks
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C) Booting
D) Memory management

Q70.     निम्न में से कौन Application Software है?
Which is application software?
A) Windows
B) Linux
C) MS Excel
D) BIOS

 SECTION–8: Development of Internet (10 MCQs)🔹

Q71.       इंटरनेट की शुरुआत किस परियोजना से हुई?
Internet originated from which project?
A) ARPANET
B) WWW
C) ISDN
D) LAN

Q72. ARPANET     किस देश में विकसित हुआ?
ARPANET was developed in?
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A) India
B) UK
C) USA
D) Japan

Q73. WWW     का पूरा नाम क्या है?
Full form of WWW is?
A) World Wide Web
B) World Web Wide
C) Wide World Web
D) Web World Wide

Q74. WWW    के जनक कौन हैं?
Father of WWW is?
A) Bill Gates
B) Tim Berners-Lee
C) Steve Jobs
D) Charles Babbage

Q75. Internet        पर सूचना किस रूप में भेजी जाती है?
Information on internet is sent as?
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A) Pages
B) Packets
C) Files
D) Documents

Q76. IP Address      का उपयोग किस लिए होता है?
IP address is used to?
A) Identify device
B) Save data
C) Print page
D) Secure password

Q77. Internet      सेवा प्रदाता को क्या कहते हैं?
Internet service provider is called?
A) ISP
B) TCP
C) HTTP
D) URL

Q78. E-mail      का उपयोग किस लिए होता है?
E-mail is used for?
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A) File storage
B) Communication
C) Gaming
D) Processing

Q79. Search Engine   का उदाहरण है?
Example of search engine is?
A) Chrome
B) Google
C) Windows
D) Yahoo Mail

Q80. URL     का पूरा नाम क्या है?
Full form of URL is?
A) Uniform Resource Locator
B) Universal Resource Link
C) Uniform Resource Link
D) Unique Resource Locator
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 SECTION–9: AEPS, BHIM, UPI, Cyber Security, Web Services, Future Skill (10 MCQs)🔹

Q81. AEPS     का पूरा नाम क्या है?
Full form of AEPS is?
A) Aadhaar Enabled Payment System
B) Advanced Electronic Payment System
C) Automated Electronic Payment Service
D) Aadhaar Electronic Public Service

Q82. AEPS     में पहचान किससे होती है?
Identification in AEPS is done by?
A) PIN
B) OTP
C) Aadhaar & biometric
D) Password

Q83. BHIM    ऐप किससे संबंधित है?
BHIM app is related to?
A) Education
B) Banking
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C) Gaming
D) Networking

Q84. UPI     का पूरा नाम क्या है?
Full form of UPI is?
A) Unified Payment Interface
B) Universal Payment India
C) Unique Payment Interface
D) United Payment India

Q85. Cyber Crime   का उदाहरण है?
Example of cyber crime is?
A) Phishing
B) Printing
C) Typing
D) Formatting

Q86. Firewall      का उपयोग किस लिए होता है?
Firewall is used for?
A) Virus creation
B) Network security
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C) Data storage
D) Speed increase

Q87. Web Service      का उपयोग किस लिए होता है?
Web services are used for?
A) Data exchange between applications
B) Gaming
C) Storage
D) Printing

Q88. Cloud computing   का उदाहरण है?
Example of cloud service is?
A) Google Drive
B) Keyboard
C) Printer
D) Scanner

Q89. Future Skill   का उदाहरण है?
Example of future skill is?
A) Typewriting
B) AI & Data Science



 MARATHON CLASS FOR CCC EXAM & OTHER                                                                                                                YORHELP EDUCATION

C) Fax
D) Photocopy

Q90. Cyber Security     का मुख्य उद्देश्य क्या है?
Main objective of cyber security is?
A) Data deletion
B) Data protection
C) Data sharing
D) Data formatting

 SECTION–10: Computer Architecture & IT Tools (10 MCQs)🔹

Q91.     कं प्यूटर आर्कि टेक्चर किससे संबंधित है?
Computer architecture is related to?
A) Software design
B) Hardware structure
C) Networking
D) Internet

Q92. Von Neumann Architecture    में क्या होता है?
Von Neumann architecture includes?



 MARATHON CLASS FOR CCC EXAM & OTHER                                                                                                                YORHELP EDUCATION

A) Separate memory
B) Same memory for data & instruction
C) Only hardware
D) Only software

Q93. Cache Memory      का उपयोग क्यों किया जाता है?
Cache memory is used to?
A) Store files
B) Increase processing speed
C) Backup data
D) Save power

Q94. Register Memory    कहाँ स्थित होती है?
Register memory is located in?
A) RAM
B) Hard disk
C) CPU
D) ROM

Q95. Bit   क्या दर्शाता है?
Bit represents?
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A) Character
B) Binary digit
C) Word
D) Instruction

Q96. Byte   में कितने bits  होते हैं?
Number of bits in a byte is?
A) 4
B) 8
C) 16
D) 32

Q97. MS Excel    किस प्रकार का IT Tool है?
MS Excel is which IT tool?
A) Database
B) Spreadsheet
C) Presentation
D) Browser

Q98. IT Tools       का उपयोग मुख्यतः किस लिए होता है?
IT tools are mainly used for?
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A) Manual work
B) Information processing
C) Writing only
D) Drawing

Q99. Presentation      बनाने के लिए कौन सा IT Tool है?
Which IT tool is used for presentation?
A) Word
B) Excel
C) PowerPoint
D) Paint

Q100. Database management tool   का उदाहरण है?
Example of DBMS tool is?
A) MS Word
B) MS Access
C) Notepad
D) Paint
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2. Operating System: Windows/ Linux : 100 MCQs
 SECTION–1: What is Operating System & Functions (101–115)🔹

Q101. Operating System  क्या है?
What is an Operating System?
A) Hardware
B) Application software
C) System software
D) Utility software

Q102. OS     का मुख्य कार्य क्या है?
Main function of OS is?
A) Typing
B) Resource management
C) Printing
D) Drawing

Q103. (True/False)
Operating System user  और hardware   के बीच interface   प्रदान करता है।
Operating system provides interface between user and hardware.
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A) True
B) False

Q104.    निम्न में से OS    का कार्य नहीं  है?
Which is NOT a function of OS?
A) Memory management
B) Process management
C) Virus creation
D) File management

Q105. OS    किसे नियंत्रित करता है?
OS controls?
A) Only software
B) Only hardware
C) Both hardware and software
D) Internet only

Q106. Multitasking    का अर्थ क्या है?
Meaning of multitasking is?
A) One task at a time
B) Multiple tasks simultaneously
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C) Shutdown system
D) Virus scan

Q107. (True/False)
OS  बिना hardware     के काम कर सकता है।
OS can work without hardware.
A) True
B) False

Q108. Time sharing OS      का उपयोग किस लिए होता है?
Time sharing OS is used for?
A) Single user
B) Multiple users
C) Offline work
D) Gaming

Q109. Real Time Operating System   का उदाहरण है?
Example of RTOS is?
A) Windows
B) Linux



 MARATHON CLASS FOR CCC EXAM & OTHER                                                                                                                YORHELP EDUCATION

C) VxWorks
D) MS Word

Q110. OS  किस memory    का उपयोग करता है?
OS uses which memory?
A) ROM only
B) RAM
C) Cache only
D) Pen drive

Q111. Kernel  क्या है?
What is kernel?
A) Hardware
B) Core part of OS
C) Application
D) Utility

Q112. (True/False)
Kernel memory  और CPU    को नियंत्रित करता है।
Kernel controls memory and CPU.
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A) True
B) False

Q113. Batch Operating System     का उपयोग किसमें होता था?
Batch OS was used in?
A) First generation computers
B) Modern PCs
C) Mobile phones
D) Tablets

Q114. Distributed OS   का उदाहरण है?
Example of distributed OS is?
A) Unix
B) Amoeba
C) DOS
D) Windows XP

Q115. OS boot      होने पर सबसे पहले क्या load  होता है?
What loads first during booting?
A) Application
B) Kernel
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C) User file
D) Browser

 SECTION–2: Types of OS & CLI vs GUI (116–130)🔹

Q116. Single user OS   का उदाहरण है?
Example of single user OS?
A) Windows
B) Unix
C) Linux Server
D) Mainframe OS

Q117. Multi-user OS   का उदाहरण है?
Example of multi-user OS?
A) MS-DOS
B) Unix
C) Windows 98
D) Android

Q118. CLI     का पूरा नाम क्या है?
Full form of CLI is?
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A) Command Line Interface
B) Common Line Interface
C) Control Line Interface
D) Computer Line Interface

Q119. GUI     का पूरा नाम क्या है?
Full form of GUI is?
A) Graphical User Interface
B) General User Interface
C) Graphic Utility Interface
D) Global User Interface

Q120. CLI   का उदाहरण है?
Example of CLI?
A) Windows desktop
B) Linux Terminal
C) Android screen
D) Mouse

Q121. (True/False)
GUI   उपयोग में CLI    से आसान होता है।
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GUI is easier than CLI.
A) True
B) False

Q122. GUI     में किसका उपयोग होता है?
GUI uses?
A) Commands only
B) Icons and mouse
C) Binary codes
D) Numbers only

Q123. CLI     का मुख्य लाभ क्या है?
Main advantage of CLI is?
A) Slow
B) Less memory usage
C) Needs mouse
D) Heavy graphics

Q124. Embedded OS     का उपयोग कहाँ होता है?
Embedded OS is used in?
A) Washing machine
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B) Laptop
C) Desktop
D) Server

Q125. Mobile OS   का उदाहरण है?
Example of mobile OS?
A) Windows XP
B) Linux
C) Android
D) DOS

Q126. (True/False)
DOS  एक GUI  आधारित OS है।
DOS is GUI based OS.
A) True
B) False

Q127. Network Operating System   का उदाहरण है?
Example of NOS is?
A) Windows Server
B) MS Paint
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C) Excel
D) Chrome

Q128. Multithreading OS   क्या करता है?
Multithreading OS performs?
A) One thread
B) Multiple threads
C) No thread
D) Shutdown

Q129. OS     का कौन सा प्रकार fastest response  देता है?
Which OS gives fastest response?
A) Batch
B) RTOS
C) Time sharing
D) Network OS

Q130. OS    का विकास क्यों हुआ?
Why OS was developed?
A) Gaming
B) Ease of use & management
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C) Internet only
D) Music

 SECTION–3: Evolution of Windows (131–145)🔹

Q131. Windows      किस कं पनी द्वारा विकसित किया गया?
Windows is developed by?
A) Apple
B) IBM
C) Microsoft
D) Google

Q132. Windows      का पहला संस्करण कौन सा था?
First version of Windows was?
A) Windows XP
B) Windows 1.0
C) Windows 95
D) Windows 7

Q133. Windows 95       किस विशेषता के लिए जाना जाता है?
Windows 95 introduced?
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A) Start Menu
B) Touch screen
C) AI
D) Cloud

Q134. (True/False)
Windows  एक GUI  आधारित OS है।
Windows is GUI based OS.
A) True
B) False

Q135. Windows XP   किस वर्ष launch हुआ?
Windows XP was launched in?
A) 1995
B) 2001
C) 2007
D) 2015

Q136. Windows 7     के बाद कौन सा version आया?
Which version came after Windows 7?
A) XP
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B) Vista
C) Windows 8
D) Windows 10

Q137. Windows 10    किस प्रकार का OS है?
Windows 10 is?
A) Single task
B) Multi task
C) Batch
D) RTOS

Q138. Windows  में file manager   क्या कहलाता है?
File manager in Windows is?
A) Finder
B) Explorer
C) Terminal
D) Shell

Q139. Control Panel      का उपयोग किस लिए होता है?
Control Panel is used for?
A) Gaming
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B) System settings
C) Browsing
D) Typing

Q140. (True/False)
Windows open source OS है।
Windows is open source OS.
A) True
B) False

Q141. Windows  का latest series    किस पर आधारित है?
Latest Windows is based on?
A) CLI
B) GUI
C) Assembly
D) DOS

Q142. Task Manager      का उपयोग किस लिए होता है?
Task Manager is used to?
A) Install OS
B) Manage running processes
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C) Print files
D) Scan virus

Q143. Windows  में shortcut key Alt+F4  का उपयोग?
Alt+F4 is used to?
A) Restart
B) Shutdown current window
C) Open file
D) Copy

Q144. Windows Defender  क्या है?
Windows Defender is?
A) Game
B) Antivirus
C) Browser
D) Editor

Q145. Windows OS      का मुख्य उपयोग कहाँ होता है?
Windows OS is mainly used in?
A) Desktop & laptop
B) Washing machine
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C) ATM only
D) Router

 SECTION–4: Linux Introduction, Developer, Features & Uses (146–170)🔹

Q146. Linux  क्या है?
Linux is a?
A) Hardware
B) Operating System
C) Browser
D) Compiler

Q147. Linux   किसने विकसित किया?
Who developed Linux?
A) Bill Gates
B) Linus Torvalds
C) Steve Jobs
D) Dennis Ritchie

Q148. (True/False)
Linux  एक open source OS है।
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Linux is an open source OS.
A) True
B) False

Q149. Linux  का kernel    किस प्रकार का है?
Linux kernel is?
A) Monolithic
B) Micro
C) Hybrid
D) Batch

Q150. Linux     का उपयोग कहाँ होता है?
Linux is used in?
A) Servers
B) Mobile (Android)
C) Supercomputers
D) All of these

Q151. Linux    की विशेषता क्या है?
Feature of Linux is?
A) Free
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B) Secure
C) Multi-user
D) All of these

Q152. Linux  में file system root directory   क्या होती है?
Root directory in Linux is?
A) C:\
B) /
C) Root
D) Home

Q153. Linux  में command       देने के लिए क्या उपयोग होता है?
To give commands in Linux we use?
A) Desktop
B) Terminal
C) Control panel
D) Explorer

Q154. Linux  का default shell   कौन सा है?
Default shell of Linux is?
A) Bash
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B) DOS
C) PowerShell
D) GUI

Q155. (True/False)
Linux virus free  होता है।
Linux is virus free.
A) True
B) False

Q156. Linux  में user home directory  का path?
Home directory path is?
A) /root
B) /home
C) /bin
D) /etc

Q157. Linux distribution   का उदाहरण है?
Example of Linux distro is?
A) Ubuntu
B) Fedora
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C) Red Hat
D) All of these

Q158. Linux  में multitasking  संभव है?
Linux supports multitasking?
A) Yes
B) No

Q159. Linux  में file permission   किससे संबंधित है?
File permission relates to?
A) Read, Write, Execute
B) Color
C) Size
D) Speed

Q160. Linux  में package manager  का उपयोग?
Package manager is used to?
A) Install software
B) Delete OS
C) Format disk
D) Shutdown
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Q161. Linux  में GUI environment   का उदाहरण है?
Example of Linux GUI is?
A) GNOME
B) KDE
C) XFCE
D) All of these

Q162. (True/False)
Linux  में source code modify    किया जा सकता है।
Linux source code can be modified.
A) True
B) False

Q163. Linux  में network management  संभव है?
Linux supports networking?
A) Yes
B) No

Q164. Linux   का उपयोग education  में क्यों?
Why Linux used in education?
A) Free



 MARATHON CLASS FOR CCC EXAM & OTHER                                                                                                                YORHELP EDUCATION

B) Secure
C) Customizable
D) All

Q165. Linux  किस license   के अंतर्गत है?
Linux is under which license?
A) GPL
B) Proprietary
C) Trial
D) Freeware only

Q166. Linux  में update   कै से होता है?
Linux updates are done via?
A) Package manager
B) BIOS
C) ROM
D) Hardware

Q167. Linux lightweight OS   है या heavy?
Linux is?
A) Heavy



 MARATHON CLASS FOR CCC EXAM & OTHER                                                                                                                YORHELP EDUCATION

B) Lightweight
C) Slow
D) Useless

Q168. Linux    किस प्रकार का OS है?
Linux is which type of OS?
A) Multi-user
B) Multitasking
C) Open source
D) All of these

Q169. Linux  का use cyber security  में क्यों?
Linux used in cyber security because?
A) Secure
B) Custom tools
C) Open source
D) All

Q170. Kali Linux     किस लिए उपयोग होता है?
Kali Linux is used for?
A) Gaming
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B) Ethical hacking
C) Accounting
D) Designing

 SECTION–5: Linux CLI Commands, GUI & Utility Software (171–200)🔹

Q171. ls command  का उपयोग?

Use of ls command?
A) List files
B) Delete files
C) Create files
D) Copy files

Q172. pwd command   क्या दिखाता है?
pwd command shows?
A) File name
B) Current directory
C) Date
D) User name
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Q173. cd command  का उपयोग?

cd command is used to?
A) Change directory
B) Copy data
C) Delete data
D) Display date

Q174. mkdir command  का कार्य?
mkdir command creates?
A) File
B) Folder
C) User
D) Process

Q175. rm command  का उपयोग?

rm command is used to?
A) Rename
B) Remove file
C) Read file
D) Restore file
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Q176. (True/False)
Linux commands case sensitive  होते हैं।
Linux commands are case sensitive.
A) True
B) False

Q177. cat command  का उपयोग?

cat command is used to?
A) Display file content
B) Copy file
C) Compress file
D) Encrypt file

Q178. chmod command   किससे संबंधित है?
chmod relates to?
A) Permission
B) Process
C) Package
D) Print
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Q179. Linux  में GUI start   करने का command?
Command to start GUI is?
A) startx
B) run
C) gui
D) load

Q180. Linux  में text editor   का उदाहरण है?
Example of Linux text editor?
A) vi
B) nano
C) gedit
D) All of these

Q181. Utility software   का उदाहरण है?
Example of utility software?
A) Antivirus
B) Disk cleanup
C) Backup tool
D) All of these
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Q182. Utility software   का मुख्य उद्देश्य?
Main purpose of utility software?
A) System maintenance
B) Gaming
C) Browsing
D) Coding

Q183. Disk Defragmenter  किस OS    में उपयोग होता है?
Disk defragmenter is mainly used in?
A) Windows
B) Linux
C) Android
D) iOS

Q184. Backup utility  का कार्य?
Backup utility is used to?
A) Delete data
B) Copy data safely
C) Slow system
D) Format disk
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Q185. Compression utility  का उदाहरण?
Example of compression utility?
A) WinZip
B) WinRAR
C) 7-Zip
D) All

Q186. Linux  में process   देखने की command?
Command to view processes?
A) ps
B) ls
C) cat
D) rm

Q187. top command  का उपयोग?

top command is used to?
A) Show running processes
B) Shutdown
C) Format
D) Install
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Q188. GUI  आधारित Linux distro  का उदाहरण?
GUI based Linux distro example?
A) Ubuntu
B) Mint
C) Fedora
D) All

Q189. (True/False)
Utility software OS    का हिस्सा होता है।
Utility software is part of system software.
A) True
B) False

Q190. Linux  में shutdown command?
Shutdown command is?
A) shutdown
B) poweroff
C) halt
D) All
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Q191. OS update  का उद्देश्य?
Purpose of OS update?
A) Security
B) Performance
C) New features
D) All

Q192. Linux  में help command?
Linux help command is?
A) help
B) man
C) info
D) All

Q193. Windows  और Linux  में common feature?
Common feature is?
A) Multitasking
B) GUI support
C) File system
D) All
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Q194. Linux  का use cloud servers  में क्यों?
Linux used in cloud because?
A) Stability
B) Security
C) Cost effective
D) All

Q195. OS  का future trend  क्या है?
Future trend of OS?
A) AI integration
B) Cloud based OS
C) IoT support
D) All

Q196. Utility software  कौन install  करता है?
Utility software is installed by?
A) User
B) OS vendor
C) Manufacturer
D) All
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Q197. OS crash   होने का कारण?
Cause of OS crash?
A) Virus
B) Hardware failure
C) Software bug
D) All

Q198. Linux terminal    किस प्रकार का interface है?
Linux terminal is?
A) GUI
B) CLI
C) Hybrid
D) None

Q199. OS  का primary goal?
Primary goal of OS?
A) Convenience
B) Efficiency
C) Resource utilization
D) All
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Q200. (True/False)
Linux  और Windows  दोनों multitasking OS हैं।
Linux and Windows both are multitasking OS.
A) True
B) False
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3. Word Processing (Libre Office Write) : 50 MCQs

 LibreOffice Writer📝
MCQs + True/False (201–250)

 QUESTIONS (201–250)🔹
 MCQs (201–235)🔸

Q201. LibreOffice Writer    में दस्तावेज़ को Save As      करने का विकल्प कहाँ होता है?
Where is Save As option in Writer?
A) Edit Menu
B) View Menu
C) File Menu
D) Tools Menu

Q202. Writer  में default page size   क्या होती है?
Default page size in Writer is?
A) Letter
B) Legal
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C) A4
D) A3

Q203. Writer  में Paragraph spacing   किससे संबंधित है?
Paragraph spacing is related to?
A) Page size
B) Space between paragraphs
C) Font size
D) Margin

Q204. Writer  में Bullets and Numbering  किस menu  में है?
Bullets and Numbering option is in?
A) Insert
B) Format
C) Tools
D) View

Q205. Writer  में Find  का shortcut key  क्या है?
Shortcut key for Find is?
A) Ctrl+H
B) Ctrl+F
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C) Ctrl+R
D) Ctrl+G

Q206. Writer  में Page Border     लगाने का विकल्प कहाँ है?
Option to apply page border is in?
A) Format → Page Style
B) Insert → Border
C) Tools → Border
D) View → Border

Q207. Writer  में Line Spacing   बदलने की shortcut key  क्या है?
Shortcut for line spacing is?
A) Ctrl+1 / Ctrl+2
B) Ctrl+L
C) Ctrl+Shift+S
D) Ctrl+M

Q208. Writer  में Text  को Highlight    करने के लिए कौन-  सा tool है?
Tool used to highlight text is?
A) Font color
B) Background color
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C) Highlight color
D) Border color

Q209. Writer  में Styles     का मुख्य लाभ क्या है?
Main advantage of Styles is?
A) Fast typing
B) Consistent formatting
C) Printing
D) Saving

Q210. Writer  में Table of Contents    बनाने का विकल्प है?
Option to create Table of Contents is?
A) Tools
B) Insert
C) Format
D) View

Q211. Writer  में Header/Footer     हटाने का विकल्प कहाँ है?
Remove Header/Footer option is in?
A) Insert
B) Format → Page Style
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C) Tools
D) View

Q212. Writer  में Page Break       डालने का उपयोग किस लिए होता है?
Page Break is used to?
A) End page manually
B) Delete page
C) Resize page
D) Add margin

Q213. Writer  में Spell Check dictionary      किस भाषा पर आधारित होती है?
Spell check dictionary depends on?
A) OS language
B) Selected document language
C) Keyboard
D) Font

Q214. Writer  में Mail Merge     किसके साथ प्रयोग होता है?
Mail Merge works with?
A) Spreadsheet / Database
B) Image
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C) Chart
D) Presentation

Q215. Writer  में Track Changes  स्वीकार (Accept)     करने का विकल्प कहाँ है?
Accept Track Changes option is in?
A) Edit
B) View
C) Tools
D) File

Q216. Writer  में Watermark    किसमें जोड़ा जाता है?
Watermark is added in?
A) Header
B) Footer
C) Page style
D) Paragraph

Q217. Writer  में Text Direction       बदलने का विकल्प किसके लिए उपयोगी है?
Text direction is useful for?
A) English only
B) Hindi only
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C) Multilingual documents
D) Images

Q218. Writer  में Footnote  और Endnote    में अंतर क्या है?
Difference between footnote and endnote?
A) Same thing
B) Footnote at bottom, endnote at end
C) Endnote at top
D) Both at header

Q219. Writer  में Comments    दिखाई कहाँ देते हैं?
Comments appear in?
A) Status bar
B) Margin
C) Header
D) Footer

Q220. Writer  में Section      का उपयोग क्यों किया जाता है?
Section is used for?
A) Page control
B) Different formatting
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C) Printing
D) Saving

Q221. Writer  में AutoText  का उपयोग?
AutoText is used for?
A) Auto formatting
B) Reusable text
C) Spell check
D) Printing

Q222. Writer  में Hyperlink insert   करने की shortcut key  क्या है?
Shortcut for hyperlink is?
A) Ctrl+H
B) Ctrl+K
C) Ctrl+L
D) Ctrl+U

Q223. Writer  में Navigator      का उपयोग किस लिए होता है?
Navigator is used for?
A) Formatting
B) Quick navigation
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C) Printing
D) Saving

Q224. Writer  में Document Statistics   कहाँ मिलती है?
Document statistics are found in?
A) File
B) Tools
C) View
D) Insert

Q225. Writer  में Change Case option  किस menu  में है?
Change Case option is in?
A) Edit
B) Format
C) Tools
D) View

Q226. Writer  में Frame      का उपयोग किस लिए होता है?
Frame is used for?
A) Image positioning
B) Text layout control
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C) Table only
D) Printing

Q227. Writer  में Page Color    बदलने का विकल्प है?
Page color option is in?
A) Format → Page Style
B) Tools
C) View
D) Insert

Q228. Writer  में ODT format   किसका उदाहरण है?
ODT format is example of?
A) Proprietary
B) Open Document Format
C) Image format
D) Video format

Q229. Writer  में Master Document  का उपयोग?
Master document is used for?
A) Single page
B) Large documents
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C) Images only
D) Tables only

Q230. Writer  में Clipboard  का उपयोग?
Clipboard is used to?
A) Store copied data temporarily
B) Save file permanently
C) Print data
D) Format text

Q231. Writer  में Font Effects   कहाँ मिलते हैं?
Font effects are found in?
A) Edit
B) Format → Character
C) View
D) Tools

Q232. Writer  में AutoSave feature   क्या करता है?
AutoSave feature does what?
A) Saves manually
B) Saves automatically at interval
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C) Prints file
D) Exports PDF

Q233. Writer  में Text  को Column     में बदलने का विकल्प है?
Option to convert text into columns is?
A) Insert
B) Format
C) Tools
D) View

Q234. Writer  में Zoom Slider   कहाँ होता है?
Zoom slider is located at?
A) Menu bar
B) Status bar
C) Tool bar
D) Title bar

Q235. Writer  में Default alignment   क्या होती है?
Default alignment in Writer is?
A) Center
B) Right
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C) Left
D) Justify

 True / False (236–250)🔸
Q236. LibreOffice Writer open source software है।
LibreOffice Writer is open source.

Q237. Writer  में .pdf file directly edit    की जा सकती है।
Q238. Writer  में Header  और Footer अलग-    अलग हो सकते हैं।
Q239. Ctrl+S   का उपयोग Save    के लिए होता है।
Q240. Writer  में Spell Check multi-language support  करता है।
Q241. Writer  के वल Windows OS   पर चलता है।
Q242. Writer  में Styles formatting    को तेज बनाते हैं।
Q243. Writer  में Image cropping   संभव नहीं  है।
Q244. Writer  में Mail Merge bulk letters     के लिए प्रयोग होता है।
Q245. Writer  में Track Changes collaboration    के लिए उपयोगी है।
Q246. Writer  में Table of Contents automatic update   हो सकता है।
Q247. Writer  में Hyperlink web page    से जोड़ सकता है।
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Q248. Writer  में Footnote reference     के लिए प्रयोग होता है।
Q249. Writer database management software है।
Q250. LibreOffice Writer MS Word  का alternative है।

 ANSWER KEY WITH BRIEF EXPLANATION (201–250)✅
20  C – Save As File menu 1️⃣   में होता है
20  C – A4 default size2️⃣
20  B – Paragraph 3️⃣   के बीच space
20  B – Formatting 4️⃣  से संबंधित
20  B – Find shortcut5️⃣
20  A – Page Style controls page6️⃣
20  A – Line spacing shortcuts7️⃣
20  C – Highlight tool8️⃣
20  B – Uniform formatting9️⃣
21  B – TOC Insert menu 0️⃣ से
21  B – Page style controls header/footer1️⃣
21  A – Manual page end2️⃣
21  B – Language based3️⃣
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21  A – Data source 4️⃣ आवश्यक
21  A – Edit menu5️⃣
21  C – Page style property6️⃣
21  C – Multi language support7️⃣
21  B – Bottom vs end8️⃣
21  B – Margin area9️⃣
22  B – Different formatting0️⃣
22  B – Reusable text1️⃣
22  B – Hyperlink shortcut2️⃣
22  B – Fast navigation3️⃣
22  B – Tools menu4️⃣
22  B – Format menu5️⃣
22  B – Layout control6️⃣
22  A – Page style7️⃣
22  B – Open format8️⃣
22  B – Large documents9️⃣
23  A – Temporary storage0️⃣
23  B – Character formatting1️⃣
23  B – Auto interval save2️⃣
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23  B – Format menu3️⃣
23  B – Status bar4️⃣
23  C – Left alignment5️⃣
23  True – Open source6️⃣
23  False – Direct edit 7️⃣ नहीं
23  True – Header/Footer 8️⃣ अलग
23  True – Save shortcut9️⃣
24  True – Multi language0️⃣
24  False – Linux/Mac 1️⃣ भी
24  True – Time saving2️⃣
24  False – Cropping possible3️⃣
24  True – Bulk letters4️⃣
24  True – Collaboration5️⃣
24  True – Auto update6️⃣
24  True – Web linking7️⃣
24  True – Reference8️⃣
24  False – Word processor9️⃣
25  True – MS Word alternative0️⃣
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4. Spreadsheet Software (Libre Office Calc) : 50 MCQs

 LibreOffice Calc📊
MCQs + True/False (251–300)

 PART–A : Objective Type MCQs (251–280)🔹
Q251. LibreOffice Calc     का मुख्य उपयोग क्या है?
What is the main use of LibreOffice Calc?
A) Word processing
B) Spreadsheet calculation
C) Presentation
D) Image editing

Q252. Calc  में Row  और Column  के intersection    को क्या कहते हैं?
Intersection of row and column is called?
A) Table
B) Cell
C) Sheet
D) Range
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Q253. Calc  में default file extension  क्या है?
Default file extension of Calc is?
A) .doc
B) .xls
C) .ods
D) .ppt

Q254. Calc  में Formula       हमेशा किस चिन्ह से शुरू होता है?
Formula in Calc always starts with?
A) +
B) #
C) =
D) $

Q255. Calc  में SUM function      का उपयोग किस लिए होता है?
SUM function is used to?
A) Count values
B) Add values
C) Find average
D) Find maximum
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Q256. Calc  में AutoSum button  किसका shortcut है?
AutoSum button is shortcut for?
A) COUNT
B) SUM
C) AVERAGE
D) MAX

Q257. Calc  में Cell Address   क्या दर्शाता है?
Cell address represents?
A) Cell color
B) Cell location
C) Cell value
D) Cell format

Q258. Calc  में Relative Cell Reference   का उदाहरण कौन-  सा है?
Example of relative cell reference is?
A) $A$1
B) A$1
C) $A1
D) A1
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Q259. Calc  में Absolute Cell Reference  का symbol  क्या है?
Symbol used for absolute reference is?
A) @
B) #
C) $
D) %

Q260. Calc  में Chart      का उपयोग किस लिए होता है?
Chart is used for?
A) Data entry
B) Graphical representation
C) Formula writing
D) Printing

Q261. Calc  में Freeze Rows and Columns  का उपयोग?
Freeze option is used to?
A) Lock data permanently
B) Keep headings visible
C) Protect file
D) Hide rows
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Q262. Calc  में Sort feature   क्या करता है?
Sort feature does what?
A) Delete data
B) Arrange data order
C) Copy data
D) Format data

Q263. Calc  में Filter  का उपयोग?
Filter is used to?
A) Hide unwanted data
B) Delete data
C) Protect data
D) Format cells

Q264. Calc  में COUNT function   क्या करता है?
COUNT function does what?
A) Counts text
B) Counts numeric cells
C) Adds values
D) Finds average
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Q265. Calc  में Sheet tab   कहाँ होता है?
Sheet tab is located at?
A) Top
B) Bottom
C) Right
D) Left

Q266. Calc  में Data Validation  का उपयोग?
Data validation is used to?
A) Enter any data
B) Restrict input data
C) Format cells
D) Delete data

Q267. Calc  में Conditional Formatting  का उपयोग?
Conditional formatting is used to?
A) Print data
B) Highlight based on condition
C) Lock cells
D) Sort data
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Q268. Calc  में Pivot Table  का उपयोग?
Pivot table is used for?
A) Image editing
B) Data analysis
C) Typing
D) Printing

Q269. Calc  में VLOOKUP function    किस लिए होता है?
VLOOKUP is used to?
A) Vertical search
B) Horizontal search
C) Sorting
D) Filtering

Q270. Calc  में Formula Bar  का उपयोग?
Formula bar is used to?
A) View and edit formulas
B) Print data
C) Insert chart
D) Apply filter
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Q271. Calc  में Spreadsheet  कितनी Sheets     से बना हो सकता है?
Spreadsheet can contain?
A) Only one sheet
B) Two sheets
C) Multiple sheets
D) No sheet

Q272. Calc  में Cell Formatting    में क्या शामिल है?
Cell formatting includes?
A) Font, border, color
B) Calculation
C) Printing
D) Sorting

Q273. Calc  में Merge Cells  का उपयोग?
Merge cells is used to?
A) Split cells
B) Combine cells
C) Delete cells
D) Lock cells
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Q274. Calc  में Print Area set   करने का लाभ?
Benefit of print area is?
A) Print whole sheet
B) Print selected area
C) Save file
D) Protect data

Q275. Calc  में Header/Footer  का उपयोग?
Header/Footer is used for?
A) Data entry
B) Page information
C) Formula
D) Sorting

Q276. Calc  में IF function   क्या करता है?
IF function does what?
A) Always true
B) Logical test
C) Add values
D) Count cells
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Q277. Calc  में Protect Sheet  का उपयोग?
Protect sheet is used to?
A) Hide sheet
B) Prevent editing
C) Delete data
D) Sort data

Q278. Calc  में Status Bar   क्या दिखाता है?
Status bar shows?
A) Menu
B) Calculation summary
C) Chart
D) Formula only

Q279. Calc  में Macros  का उपयोग?
Macros are used to?
A) Automate tasks
B) Format text
C) Insert image
D) Print data
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Q280. LibreOffice Calc    किस प्रकार का software है?
LibreOffice Calc is a type of?
A) System software
B) Application software
C) Utility software
D) Programming software

 PART–B : True / False (281–300)🔹
Q281. LibreOffice Calc  एक spreadsheet software  है। (True/False)
Q282. Calc  में Formula  बिना =     के शुरू हो सकता है।
Q283. SUM function  के वल text  जोड़ता है।
Q284. Calc  में Multiple sheets   हो सकती हैं।
Q285. Cell A1  एक valid cell address है।
Q286. Absolute reference  में $ symbol    का उपयोग होता है।
Q287. Calc  में Chart data  को visually  दिखाता है।
Q288. Filter  से data delete   हो जाता है।
Q289. Conditional formatting rules based  होती हैं।
Q290. Pivot Table data analysis    में मदद करता है।
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Q291. Calc  के वल Windows   पर चलता है।
Q292. Data validation  गलत entry  रोकता है।
Q293. IF function logical test  करता है।
Q294. Freeze pane headings  को visible  रखता है।
Q295. LibreOffice Calc paid software है।
Q296. VLOOKUP vertical search  करता है।
Q297. Merge cells  से cells combine  होते हैं।
Q298. Print area set    करने से पूरा sheet print  होता है।
Q299. Calc  में Macros automation   के लिए हैं।
Q300. LibreOffice Calc MS Excel  का alternative है।

 ANSWER KEY WITH BRIEF EXPLANATION (251–300)✅
 MCQs🔸

25  1️⃣B – Spreadsheet calculations
25  2️⃣B – Cell = Row + Column
25  3️⃣C – OpenDocument Spreadsheet
25  4️⃣C – Formula always starts with =
25  5️⃣B – Addition of values
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25  6️⃣B – AutoSum = SUM
25  7️⃣B – Cell location
25  8️⃣D – Relative reference
25  9️⃣C – $ symbol
26  0️⃣B – Graphical representation
26  1️⃣B – Headings visible
26  2️⃣B – Arrange data
26  3️⃣A – Hide unwanted data
26  4️⃣B – Counts numbers
26  5️⃣B – Bottom of window
26  6️⃣B – Restrict data entry
26  7️⃣B – Condition based formatting
26  8️⃣B – Data analysis
26  9️⃣A – Vertical lookup
27  0️⃣A – Formula editing
27  1️⃣C – Multiple sheets
27  2️⃣A – Cell appearance
27  3️⃣B – Combine cells
27  4️⃣B – Selected area print
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27  5️⃣B – Page info
27  6️⃣B – Logical test
27  7️⃣B – Prevent editing
27  8️⃣B – Summary info
27  9️⃣A – Automation
28  0️⃣B – Application software

 True / False🔸
28  1️⃣True
28  2️⃣False
28  3️⃣False
28  4️⃣True
28  5️⃣True
28  6️⃣True
28  7️⃣True
28  8️⃣False
28  9️⃣True
29  0️⃣True
29  1️⃣False
29  2️⃣True
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29  3️⃣True
29  4️⃣True
29  5️⃣False
29  6️⃣True
29  7️⃣True
29  8️⃣False
29  9️⃣True
30  0️⃣True
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5. Presentation Software (Libre Office Impress) : 50 MCQs

 LibreOffice Impress�
MCQs + True/False (301–350)

 PART–A : Objective Type MCQs (301–330)🔹
Q301. LibreOffice Impress     का मुख्य उपयोग क्या है?
What is the main use of LibreOffice Impress?
A) Spreadsheet calculation
B) Presentation creation
C) Word processing
D) Image editing

Q302. Impress   में एक slide  में text       डालने के लिए क्या उपयोग होता है?
To insert text in a slide, what is used?
A) Frame
B) Text Box
C) Table
D) Chart
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Q303. Impress  में default file extension  क्या है?
Default file extension of Impress is?
A) .odp
B) .ods
C) .odt
D) .ppt

Q304. Impress   में नई slide   जोड़ने का shortcut key  क्या है?
Shortcut key to insert new slide is?
A) Ctrl+N
B) Ctrl+M
C) Ctrl+Shift+N
D) Ctrl+Enter

Q305. Impress  में Slide Layout      का उपयोग किस लिए होता है?
Slide Layout is used for?
A) Slide design structure
B) Animation
C) Printing
D) Saving
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Q306. Impress  में Slide Master  का उपयोग?
Slide Master is used for?
A) Individual slide formatting
B) Overall presentation design
C) Text typing
D) Animation only

Q307. Impress  में Transition  का उपयोग?
Slide transition is used for?
A) Text editing
B) Slide change effect
C) Sound recording
D) Printing

Q308. Impress  में Animation      का उपयोग किस पर होता है?
Animation is applied on?
A) Slide only
B) Objects/Text
C) Background only
D) Notes
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Q309. Impress  में Presentation  को Slide Show mode    में चलाने का shortcut?
Shortcut to start slide show is?
A) F2
B) F5
C) F7
D) Ctrl+F5

Q310. Impress  में Handout View  का उपयोग?
Handout view is used for?
A) Editing slides
B) Printing slides per page
C) Slide animation
D) Notes editing

Q311. Impress  में Notes View  का उपयोग?
Notes view is used for?
A) Audience notes
B) Presenter notes
C) Animation
D) Printing only
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Q312. Impress  में Bullet  और Numbering  का उपयोग?
Bullets and numbering are used for?
A) Decoration
B) Organizing points
C) Animation
D) Printing

Q313. Impress  में Background   बदलने का विकल्प?
Option to change background is in?
A) Format → Page
B) Insert → Background
C) Tools → Background
D) View → Background

Q314. Impress  में Slide Sorter View  का उपयोग?
Slide sorter view is used to?
A) Edit text
B) Rearrange slides
C) Apply animation
D) Print slides



 MARATHON CLASS FOR CCC EXAM & OTHER                                                                                                                YORHELP EDUCATION

Q315. Impress  में Hyperlink     किसके लिए प्रयोग होता है?
Hyperlink is used to?
A) Insert image
B) Link to slide/web
C) Animate text
D) Print

Q316. Impress  में Chart  का उपयोग?
Charts are used for?
A) Showing data graphically
B) Typing text
C) Animation
D) Sound

Q317. Impress  में Font Formatting  का उपयोग?
Font formatting is used to?
A) Change text appearance
B) Insert slide
C) Print
D) Save
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Q318. Impress  में Custom Animation  किस menu  में है?
Custom animation is found in?
A) Insert
B) Slide Show
C) Format
D) View

Q319. Impress  में Presentation Timer  का उपयोग?
Presentation timer is used for?
A) Track time
B) Insert animation
C) Print
D) Save

Q320. Impress  में Multimedia insert   करने का विकल्प?
Option to insert multimedia is in?
A) File
B) Insert
C) View
D) Tools
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Q321. Impress  में Presenter Console  का उपयोग?
Presenter console is used for?
A) Audience view
B) Presenter assistance
C) Printing
D) Saving

Q322. Impress  में Duplicate Slide  का उपयोग?
Duplicate slide is used to?
A) Delete slide
B) Copy slide
C) Hide slide
D) Lock slide

Q323. Impress  में Hide Slide option  का उपयोग?
Hide slide is used to?
A) Delete slide
B) Skip slide in show
C) Lock slide
D) Rename slide
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Q324. Impress  में Align tools  का उपयोग?
Align tools are used to?
A) Align objects
B) Insert slides
C) Print
D) Save

Q325. Impress  में Export as PDF  का उपयोग?
Export as PDF is used to?
A) Edit presentation
B) Share easily
C) Animate slides
D) Record sound

Q326. Impress  में Master Slide changes     किस पर लागू होते हैं?
Master slide changes apply to?
A) One slide
B) Selected slide
C) All slides
D) Notes only
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Q327. Impress  में Transition sound  का उपयोग?
Transition sound is used for?
A) Slide change audio
B) Background music
C) Recording
D) Printing

Q328. Impress  में Slide Number insert   करने का विकल्प?
Option to insert slide number is in?
A) Insert
B) Format
C) Tools
D) View

Q329. Impress  में Animation Pane   किस लिए है?
Animation pane is used to?
A) Manage animations
B) Insert chart
C) Print
D) Save
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Q330. LibreOffice Impress    किस प्रकार का software है?
LibreOffice Impress is a type of?
A) System software
B) Application software
C) Utility software
D) Programming software

 PART–B : True / False (331–350)🔹
Q331. LibreOffice Impress presentation   बनाने का software  है। (True/False)
Q332. Impress   में एक presentation  में multiple slides   हो सकती हैं।
Q333. Ctrl+M   से नई slide insert  होती है।
Q334. Slide Master  सभी slides   पर समान design   लागू करता है।
Q335. Transition  के वल text    पर लागू होती है।
Q336. Animation objects  और text      दोनों  पर लागू हो सकती है।
Q337. Impress  में Audio  और Video insert    किया जा सकता है।
Q338. Handout view presentation     दिखाने के लिए होता है।
Q339. Notes view presenter    के लिए उपयोगी है।
Q340. Impress  के वल Windows OS   पर चलता है।
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Q341. Hide slide   करने से slide delete   हो जाती है।
Q342. Slide sorter view slides  को rearrange     करने में मदद करता है।
Q343. Hyperlink  से web page  या slide  से link    किया जा सकता है।
Q344. Impress  में PDF export    की सुविधा नहीं  है।
Q345. Align tools objects    को ठीक से arrange  करते हैं।
Q346. Presenter Console presenter    को सहायता देता है।
Q347. Slide number header/footer     का भाग हो सकता है।
Q348. Master slide    में बदलाव सभी slides    पर लागू होते हैं।
Q349. LibreOffice Impress paid software है।
Q350. LibreOffice Impress MS PowerPoint  का alternative है।

 ANSWER KEY WITH BRIEF EXPLANATION (301–350)✅
 MCQs🔸

30  1️⃣B – Presentation creation
30  2️⃣B – Text Box
30  3️⃣A – OpenDocument Presentation
30  4️⃣B – Ctrl+M
30  5️⃣A – Slide structure
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30  6️⃣B – Overall design
30  7️⃣B – Slide change effect
30  8️⃣B – Objects/Text
30  9️⃣B – F5
31  0️⃣B – Printing multiple slides
31  1️⃣B – Presenter notes
31  2️⃣B – Organize points
31  3️⃣A – Page format
31  4️⃣B – Rearranging slides
31  5️⃣B – Linking
31  6️⃣A – Graphical data
31  7️⃣A – Text appearance
31  8️⃣B – Slide Show menu
31  9️⃣A – Time tracking
32  0️⃣B – Insert menu
32  1️⃣B – Presenter help
32  2️⃣B – Copy slide
32  3️⃣B – Skip slide
32  4️⃣A – Align objects
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32  5️⃣B – Easy sharing
32  6️⃣C – All slides
32  7️⃣A – Audio on transition
32  8️⃣A – Insert menu
32  9️⃣A – Manage animations
33  0️⃣B – Application software

 True / False🔸
33  1️⃣True
33  2️⃣True
33  3️⃣True
33  4️⃣True
33  5️⃣False
33  6️⃣True
33  7️⃣True
33  8️⃣False
33  9️⃣True
34  0️⃣False
34  1️⃣False
34  2️⃣True
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34  3️⃣True
34  4️⃣False
34  5️⃣True
34  6️⃣True
34  7️⃣True
34  8️⃣True
34  9️⃣False
35  0️⃣True
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6. Introduction to Internet, WWW and Web Services : 100 MCQs

 Internet, Networks, WWW & Web Services 🌐
Q351. Internet  क्या है?

What is Internet?
A) Single computer
B) Network of networks
C) Software
D) Website

Q352. Internet       की शुरुआत किस परियोजना से हुई थी?
Internet originated from which project?
A) WWW
B) ARPANET
C) NSFNET
D) Intranet
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Q353. ARPANET     किस वर्ष शुरू हुआ था?
ARPANET was started in which year?
A) 1955
B) 1969
C) 1975
D) 1985

Q354. WWW     का पूरा नाम क्या है?
Full form of WWW is?
A) World Web Wide
B) World Wide Web
C) Web World Wide
D) World Wireless Web

Q355. WWW    के आविष्कारक कौन हैं?
Who invented the World Wide Web?
A) Bill Gates
B) Vint Cerf
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C) Tim Berners-Lee
D) Steve Jobs

Q356. WWW    किस पर आधारित है?
WWW is based on?
A) FTP
B) HTTP
C) SMTP
D) POP3

Q357. Website         में प्रयोग होने वाली मुख्य भाषा कौन सी है?
Main language used for websites is?
A) C
B) HTML
C) Java
D) Python
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Q358. HTML     का पूरा नाम क्या है?
Full form of HTML is?
A) High Text Machine Language
B) Hyper Text Markup Language
C) Hyper Tool Mark Language
D) Hyperlinks Text Machine Language

Q359. Web Browser     का उदाहरण कौन सा है?
Which is an example of web browser?
A) Google
B) Chrome
C) Yahoo
D) HTTP

Q360.    निम्न में से Search Engine   कौन सा है?
Which of the following is a search engine?
A) Firefox
B) Bing
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C) HTML
D) ISP

Q361. URL     का पूरा नाम क्या है?
Full form of URL is?
A) Uniform Resource Locator
B) Universal Resource Link
C) Uniform Resource Link
D) Universal Resource Locator

Q362. Domain Name      का उपयोग किस लिए होता है?
Domain name is used for?
A) IP address    को आसान नाम देना
B) Data encryption
C) Email भेजना
D) File download
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Q363.    निम्न में से Top Level Domain (TLD)   कौन सा है?
Which is a Top Level Domain?
A) .www
B) .html
C) .com
D) .http

Q364. .in domain     किस देश से संबंधित है?
.in domain belongs to which country?
A) Indonesia
B) Iran
C) India
D) Ireland

Q365. Web Page  क्या है?
What is a web page?
A) Internet software
B) Single document on WWW
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C) Network
D) Protocol

Q366. Website   क्या होती है?
What is a website?
A) Single web page
B) Collection of web pages
C) Web browser
D) Server

Q367. HTTP  एक ______ है।
HTTP is a ______.
A) Language
B) Browser
C) Protocol
D) Hardware
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Q368.    सुरक्षित वेबसाइट किस protocol    का उपयोग करती है?
Secure websites use which protocol?
A) HTTP
B) FTP
C) HTTPS
D) SMTP

Q369. ISP     का पूरा नाम क्या है?
Full form of ISP is?
A) Internet System Provider
B) Internet Service Provider
C) Internal Service Provider
D) International Service Protocol

Q370.    निम्न में से Internet    सेवा कौन सी है?
Which is an Internet service?
A) Email
B) Printer
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C) Scanner
D) Monitor

Q371. LAN     का पूरा नाम क्या है?
Full form of LAN is?
A) Large Area Network
B) Local Area Network
C) Long Area Network
D) Logical Area Network

Q372. WAN     का उदाहरण कौन सा है?
Which is an example of WAN?
A) Home network
B) School network
C) Internet
D) Bluetooth
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Q373.        निम्न में से कौन सा नेटवर्क डिवाइस है?
Which of the following is a network device?
A) Router
B) Keyboard
C) Monitor
D) Printer

Q374. Router     का मुख्य कार्य क्या है?
Main function of router is?
A) Store data
B) Route data packets
C) Display data
D) Print data

Q375. Modem      का उपयोग किस लिए होता है?
Modem is used for?
A) Typing
B) Modulation and Demodulation



 MARATHON CLASS FOR CCC EXAM & OTHER                                                                                                                YORHELP EDUCATION

C) Printing
D) Storage

Q376. IP Address   क्या दर्शाता है?
What does IP address represent?
A) User name
B) Computer address
C) Website name
D) Protocol name

Q377. IPv4   में कितने bits  होते हैं?
How many bits are in IPv4?
A) 16
B) 32
C) 64
D) 128
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Q378.    निम्न में से Private IP Address   कौन सा है?
Which of the following is a private IP?
A) 8.8.8.8
B) 192.168.1.1
C) 1.1.1.1
D) 172.0.0.1

Q379. FTP      का उपयोग किस लिए होता है?
FTP is used for?
A) Email
B) File transfer
C) Chat
D) Video call

Q380. Email      भेजने के लिए कौन सा protocol   उपयोग होता है?
Which protocol is used to send email?
A) POP3
B) IMAP
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C) SMTP
D) FTP

Q381. POP3      का उपयोग किस लिए होता है?
POP3 is used for?
A) Sending email
B) Receiving email
C) Browsing
D) File transfer

Q382. Web Development  में Front-end   किससे संबंधित है?
Front-end is related to?
A) Server
B) Database
C) User Interface
D) Network
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Q383. CSS      का उपयोग किस लिए होता है?
CSS is used for?
A) Structure
B) Styling
C) Logic
D) Database

Q384. JavaScript      का उपयोग किस लिए होता है?
JavaScript is used for?
A) Styling only
B) Interactivity
C) Database
D) Server hardware

Q385. Backend development        में कौन सी भाषा प्रयुक्त हो सकती है?
Which language can be used for backend?
A) HTML
B) CSS
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C) PHP
D) XML

Q386. Web Server     का उदाहरण कौन सा है?
Which is an example of web server?
A) Apache
B) Chrome
C) Android
D) Windows

Q387. Cloud computing   का अर्थ है?
Meaning of cloud computing is?
A) Local storage
B) Internet based services
C) Hardware only
D) Software installation
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Q388. Web Service  क्या है?
What is a web service?
A) Website
B) Software over internet
C) Hardware device
D) Browser

Q389. REST     का पूरा नाम क्या है?
Full form of REST is?
A) Remote State Transfer
B) Representational State Transfer
C) Reliable State Transfer
D) Resource State Transfer

Q390. API      का उपयोग किस लिए होता है?
API is used for?
A) Hardware connection
B) Software communication
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C) Internet speed
D) Website hosting

Q391.      निम्न में से कौन सा wired network   का उदाहरण है?
Which of the following is a wired network?
A) Wi-Fi
B) Bluetooth
C) Ethernet
D) Infrared

Q392. Wi-Fi     किस प्रकार का नेटवर्क है?
Wi-Fi is a type of?
A) Wired network
B) Wireless network
C) Optical network
D) Satellite network

Q393. Bluetooth       का उपयोग मुख्यतः किस लिए होता है?
Bluetooth is mainly used for?
A) Long distance communication
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B) Short range communication
C) Internet browsing
D) Website hosting

Q394. Network Topology  क्या है?
What is network topology?
A) Network speed
B) Physical/logical arrangement of network
C) Network software
D) Network protocol

Q395.      निम्न में से कौन सी Bus topology   की विशेषता है?
Which is a feature of bus topology?
A) Central hub
B) Ring connection
C) Single backbone cable
D) Mesh connection
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Q396. Star topology    में कौन सा device   मुख्य होता है?
Which device is central in star topology?
A) Switch/Hub
B) Cable
C) Node
D) Modem

Q397. Ring topology  में data   कै से चलता है?
In ring topology data flows?
A) Randomly
B) One direction
C) Both directions
D) No direction

Q398. MAN     का पूरा नाम क्या है?
Full form of MAN is?
A) Main Area Network
B) Metropolitan Area Network
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C) Medium Area Network
D) Mobile Area Network

Q399.      निम्न में से कौन सा Network Protocol है?
Which of the following is a network protocol?
A) HTML
B) TCP/IP
C) Browser
D) Website

Q400. TCP/IP model   में कितनी layers  होती हैं?
How many layers are in TCP/IP model?
A) 3
B) 4
C) 5
D) 7
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Q401. DNS    का कार्य क्या है?
What is the function of DNS?
A) Encrypt data
B) Convert domain to IP
C) Send email
D) Store files

Q402.      निम्न में से कौन सा Dynamic Website   का उदाहरण है?
Which is an example of dynamic website?
A) Static HTML page
B) Blog with comments
C) PDF file
D) Image gallery only

Q403. Static Website    की विशेषता क्या है?
Feature of static website is?
A) Database used
B) Same content for all users
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C) User login
D) Real-time update

Q404. CMS     का पूरा नाम क्या है?
Full form of CMS is?
A) Content Management System
B) Central Management Software
C) Computer Managed Service
D) Content Markup System

Q405. WordPress   किसका उदाहरण है?
WordPress is an example of?
A) Web browser
B) CMS
C) Programming language
D) Search engine
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Q406. Web Hosting    का अर्थ क्या है?
Meaning of web hosting is?
A) Website designing
B) Website storage on server
C) Website browsing
D) Website security

Q407.      निम्न में से कौन सा Free Hosting   का उदाहरण है?
Which is an example of free hosting?
A) AWS
B) Google Cloud
C) GitHub Pages
D) Azure

Q408. Web Server  और Client   के बीच communication   किससे होती है?
Communication between web server and client occurs via?
A) HTML
B) HTTP/HTTPS



 MARATHON CLASS FOR CCC EXAM & OTHER                                                                                                                YORHELP EDUCATION

C) FTP
D) SMTP

Q409. Cookie      का उपयोग किस लिए होता है?
Cookies are used for?
A) Virus protection
B) User session tracking
C) Website designing
D) Email sending

Q410. Cache memory  का web  में उपयोग?

Use of cache memory in web is?
A) Slow loading
B) Faster loading
C) Data loss
D) Virus protection
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Q411. Web 1.0    की विशेषता क्या थी?
Feature of Web 1.0 was?
A) Read only
B) Read-write
C) User interaction
D) Social media

Q412. Web 2.0   का मुख्य उद्देश्य?

Main objective of Web 2.0 is?
A) Static content
B) User participation
C) Offline use
D) Hardware support

Q413. Social Media Web    का कौन सा version है?
Social media belongs to which web version?
A) Web 1.0
B) Web 2.0
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C) Web 3.0
D) Web 4.0

Q414. Web 3.0       को किस नाम से जाना जाता है?
Web 3.0 is also known as?
A) Static Web
B) Semantic Web
C) Social Web
D) Open Web

Q415. Semantic Web    का उद्देश्य क्या है?
Goal of semantic web is?
A) Human readable data
B) Machine understandable data
C) Faster internet
D) Website design
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Q416. E-Commerce  का अर्थ?
Meaning of E-Commerce is?
A) Electronic mail
B) Online buying and selling
C) Online education
D) Online chatting

Q417.      निम्न में से कौन सा Web Service   का प्रकार है?
Which is a type of web service?
A) SOAP
B) FTP
C) LAN
D) HTML

Q418. SOAP    किस पर आधारित है?
SOAP is based on?
A) HTML
B) XML
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C) JSON
D) HTTP only

Q419. JSON     का पूरा नाम क्या है?
Full form of JSON is?
A) Java Source Object Notation
B) JavaScript Object Notation
C) Java Script Online Network
D) Java Structured Object Name

Q420. API       का उपयोग मुख्यतः किस लिए होता है?
API is mainly used for?
A) Database storage
B) Application integration
C) Hardware control
D) Network cable
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Q421. IoT     का पूरा नाम क्या है?
Full form of IoT is?
A) Internet of Technology
B) Internet of Things
C) Integration of Technology
D) Internal Online Things

Q422. Smart devices  किस technology   पर आधारित हैं?
Smart devices are based on?
A) IoT
B) LAN
C) MAN
D) FTP

Q423. Big Data    का अर्थ क्या है?
Meaning of Big Data is?
A) Small files
B) Huge volume of data
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C) Image data only
D) Internet speed

Q424. Cloud Service     का उदाहरण कौन सा है?
Which is an example of cloud service?
A) Google Drive
B) Pen Drive
C) Hard Disk
D) DVD

Q425. SaaS     का पूरा नाम क्या है?
Full form of SaaS is?
A) Software as a Service
B) System as a Software
C) Storage as a Service
D) Security as a Service
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Q426. Phishing  क्या है?
What is phishing?
A) Virus attack
B) Data backup
C) Fraud to steal information
D) Network topology

Q427. Firewall  का उपयोग?

Use of firewall is?
A) Increase speed
B) Network security
C) Data storage
D) Printing

Q428. Two-factor authentication  का अर्थ?
Meaning of two-factor authentication is?
A) Two passwords
B) Double login
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C) Two level security
D) Two users

Q429. HTTPS  ‘में S’    का अर्थ क्या है?
‘S’ in HTTPS stands for?
A) System
B) Secure
C) Server
D) Service

Q430.    निम्न में से Future Skill   कौन सा है?
Which of the following is a future skill?
A) Typewriting
B) Artificial Intelligence
C) Fax
D) Photocopy
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 True / False Questions (431–450)🔹
431.Internet network of networks है।
432.WWW  और Internet    एक ही चीज़ हैं।
433.HTTP  एक protocol है।
434.HTTPS    अधिक सुरक्षित होता है।
435.IP address unique  होता है।
436.DNS domain name  को IP   में बदलता है।
437.Static website  में database   जरूरी होता है।
438.Dynamic website user interaction allow  करती है।
439.Web 2.0  में social media  शामिल है।
440.Web 3.0  को Semantic Web  कहते हैं।
441.Cloud computing  में data internet  पर store  होता है।
442.API software     को आपस में जोड़ता है।
443.SOAP XML   आधारित होता है।
444.JSON lightweight data format है।
445.Phishing  एक cyber crime है।
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446.Firewall security provide  करता है।
447.IoT  में smart devices   जुड़े होते हैं।
448.SaaS cloud service   का प्रकार है।
449.Big Data small data   को कहते हैं।
450.AI future skill  नहीं  है।

 ANSWER KEY WITH BRIEF EXPLANATION (351–450)✅
 MCQs (351–430) – 🔸 Correct Options

35  B – Network of networks1️⃣
35  B – ARPANET2️⃣
35  B – 19693️⃣
35  B – World Wide Web4️⃣
35  C – Tim Berners-Lee5️⃣
35  B – HTTP6️⃣
35  B – HTML7️⃣
35  B – Hyper Text Markup Language8️⃣
35  B – Chrome9️⃣
36  B – Bing0️⃣
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36  A – Uniform Resource Locator1️⃣
36  A – Easy name for IP2️⃣
36  C – .com3️⃣
36  C – India4️⃣
36  B – Single document5️⃣
36  B – Collection of pages6️⃣
36  C – Protocol7️⃣
36  C – HTTPS8️⃣
36  B – Internet Service Provider9️⃣
37  A – Email0️⃣
37  B – Local Area Network1️⃣
37  C – Internet2️⃣
37  A – Router3️⃣
37  B – Route packets4️⃣
37  B – Modulation/Demodulation5️⃣
37  B – Computer address6️⃣
37  B – 32 bits7️⃣
37  B – Private IP8️⃣
37  B – File transfer9️⃣
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38  C – SMTP0️⃣
38  B – Receiving email1️⃣
38  C – User interface2️⃣
38  B – Styling3️⃣
38  B – Interactivity4️⃣
38  C – PHP5️⃣
38  A – Apache6️⃣
38  B – Internet based services7️⃣
38  B – Software over internet8️⃣
38  B – Representational State Transfer9️⃣
39  B – Software communication0️⃣
39  C – Ethernet1️⃣
39  B – Wireless2️⃣
39  B – Short range3️⃣
39  B – Network structure4️⃣
39  C – Backbone cable5️⃣
39  A – Hub/Switch6️⃣
39  B – One direction7️⃣
39  B – Metropolitan Area Network8️⃣
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39  B – TCP/IP9️⃣
40  B – 4 layers0️⃣
40  B – Domain to IP1️⃣
40  B – Dynamic website2️⃣
40  B – Same content3️⃣
40  A – Content Management System4️⃣
40  B – CMS5️⃣
40  B – Server storage6️⃣
40  C – GitHub Pages7️⃣
40  B – HTTP/HTTPS8️⃣
40  B – Session tracking9️⃣
41  B – Faster loading0️⃣
41  A – Read only1️⃣
41  B – User participation2️⃣
41  B – Web 2.03️⃣
41  B – Semantic Web4️⃣
41  B – Machine understandable5️⃣
41  B – Online buying/selling6️⃣
41  A – SOAP7️⃣
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41  B – XML8️⃣
41  B – JavaScript Object Notation9️⃣
42  B – Integration0️⃣
42  B – Internet of Things1️⃣
42  A – IoT2️⃣
42  B – Huge data3️⃣
42  A – Google Drive4️⃣
42  A – Software as a Service5️⃣
42  C – Fraud6️⃣
42  B – Security7️⃣
42  C – Two level security8️⃣
42  B – Secure9️⃣
43  B – AI0️⃣

 True / False🔸
43  True1️⃣
43  False2️⃣
43  True3️⃣
43  True4️⃣
43  True5️⃣
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43  True6️⃣
43  False7️⃣
43  True8️⃣
43  True9️⃣
44  True0️⃣
44  True1️⃣
44  True2️⃣
44  True3️⃣
44  True4️⃣
44  True5️⃣
44  True6️⃣
44  True7️⃣
44  True8️⃣
44  False9️⃣
45  False0️⃣
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7. E-Mail, Social Networking and e-Governance Services: : 100 MCQs

 E-Mail, Social Networking & e-Governance Services 📧📱

Q401-mail     का पूरा नाम क्या है?
What is the full form of E-mail?
A) Easy Mail
B) Electronic Mail
C) Extra Mail
D) External Mail

Q402. E-mail        का उपयोग मुख्यतः किस लिए किया जाता है?
E-mail is mainly used for?
A) Video calling
B) Sending electronic messages
C) Website designing
D) Data processing
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Q403.      निम्न में से कौन सा E-mail protocol है?
Which of the following is an e-mail protocol?
A) HTTP
B) FTP
C) SMTP
D) TCP

Q404. Incoming e-mail       प्राप्त करने के लिए कौन सा protocol   उपयोग होता है?
Which protocol is used to receive incoming e-mails?
A) SMTP
B) POP3 / IMAP
C) HTTP
D) DNS

Q405. IMAP protocol    की विशेषता क्या है?
What is a feature of IMAP protocol?
A) Mail delete automatically
B) Mail stored on server
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C) Only sending mail
D) Offline only

Q406.      निम्न में से कौन सा free e-mail service provider है?
Which of the following is a free e-mail service provider?
A) Gmail
B) Yahoo Mail
C) Outlook
D) All of the above

Q407. CC     का पूरा नाम क्या है?
What is the full form of CC in e-mail?
A) Carbon Copy
B) Current Copy
C) Common Copy
D) Central Copy
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Q408. BCC      का उपयोग क्यों किया जाता है?
Why is BCC used?
A) Show all recipients
B) Hide recipient addresses
C) Increase speed
D) Attach files

Q409. Attachment    का अर्थ क्या है?
What does attachment mean in e-mail?
A) Signature
B) Extra message
C) File sent with mail
D) Spam

Q410. Spam e-mail   क्या होती है?
What is spam e-mail?
A) Important mail
B) Junk / unwanted mail
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C) Official mail
D) Secure mail

Q411. Phishing e-mail     का उद्देश्य क्या होता है?
Purpose of phishing e-mail is?
A) Data backup
B) Steal personal information
C) Virus removal
D) Speed increase

Q412. Digital Signature      का उपयोग किस लिए होता है?
Digital signature is used for?
A) Decoration
B) Authentication & integrity
C) Compression
D) Storage
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Q413. Two-factor authentication    क्या प्रदान करता है?
Two-factor authentication provides?
A) Speed
B) Extra security
C) Storage
D) Virus

Q414. Social Networking Site     का उदाहरण कौन सा है?
Which is an example of social networking site?
A) Facebook
B) Twitter (X)
C) Instagram
D) All of the above

Q415. Social media     का मुख्य उद्देश्य क्या है?
Main objective of social media is?
A) Networking & sharing
B) Programming
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C) Accounting
D) Printing

Q416.      निम्न में से कौन सा professional networking site है?
Which is a professional networking site?
A) Facebook
B) LinkedIn
C) Instagram
D) Snapchat

Q417. Social media addiction      का प्रभाव क्या हो सकता है?
Effect of social media addiction can be?
A) Increased productivity
B) Mental stress
C) Faster internet
D) Virus protection
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Q418. Fake news    अधिकतर कहाँ फै लती है?
Fake news spreads mostly through?
A) Books
B) Newspapers
C) Social media
D) Offline meetings

Q419. Cyber bullying  क्या है?
What is cyber bullying?
A) Online shopping
B) Online harassment
C) Data backup
D) Email encryption

Q420. e-Governance    का अर्थ क्या है?
Meaning of e-Governance is?
A) Electronic government services
B) Manual government work
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C) Private services
D) Banking only

Q421. e-Governance   का मुख्य उद्देश्य?

Main objective of e-Governance is?
A) Transparency & efficiency
B) Increase paperwork
C) Delay services
D) Offline system

Q422.    भारत सरकार की Official websites  किस domain    का उपयोग करती हैं?
Indian government official websites use which domain?
A) .com
B) .edu
C) .gov / .nic.in
D) .org
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Q423. NIC     का पूरा नाम क्या है?
Full form of NIC is?
A) National Information Centre
B) National Informatics Centre
C) Network Information Cell
D) New India Computer

Q424. NIC     का मुख्य कार्य क्या है?
Main function of NIC is?
A) Hardware selling
B) IT support to government
C) Social networking
D) Private hosting

Q425. Kisan App       का उपयोग किस लिए किया जाता है?
Kisan App is used for?
A) Banking
B) Farmer information & services
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C) Education
D) Transport

Q426.         आय जाति प्रमाण पत्र ऑनलाइन कहाँ से बनता है?
Income & Caste certificate is issued online through?
A) Social media
B) e-District / State portal
C) Private website
D) Email

Q427. e-District portal   किससे संबंधित है?
e-District portal is related to?
A) Entertainment
B) Citizen services
C) Gaming
D) Advertising
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Q428. NIELIT  क्या है?
What is NIELIT?
A) IT company
B) Government IT education institute
C) Social site
D) Bank

Q429. NIELIT      किस मंत्रालय के अंतर्गत आता है?
NIELIT comes under which ministry?
A) Education
B) MeitY
C) Health
D) Finance

Q430. MeitY     का पूरा नाम क्या है?
Full form of MeitY is?
A) Ministry of Electronics and IT
B) Ministry of Education and IT
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C) Ministry of Economy and IT
D) Ministry of Energy and IT

Q431. DigiLocker      का उपयोग किस लिए होता है?
DigiLocker is used for?
A) Online shopping
B) Digital document storage
C) Video calling
D) Gaming

Q432. UMANG App   किससे संबंधित है?
UMANG app is related to?
A) Games
B) Multiple government services
C) Banking only
D) Social media
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Q433. Ayushman Bharat App    का संबंध किससे है?
Ayushman Bharat app is related to?
A) Education
B) Health services
C) Transport
D) Tax

Q434. Online exam portal      का उपयोग क्यों किया जाता है?
Online exam portal is used for?
A) Entertainment
B) Conducting exams digitally
C) Banking
D) Shopping

Q435. e-Hospital   सेवा का उद्देश्य?

Purpose of e-Hospital service is?
A) Online shopping
B) Hospital appointment & records
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C) Banking
D) Email

Q436. m-Governance    का अर्थ क्या है?
Meaning of m-Governance is?
A) Manual governance
B) Mobile based governance
C) Machine governance
D) Mixed governance

Q437. Digital India initiative  का उद्देश्य?

Objective of Digital India is?
A) Digital empowerment
B) Paper work
C) Manual records
D) Offline services
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Q438. Innovation in governance     का उदाहरण कौन सा है?
Which is an example of innovation in governance?
A) DigiLocker
B) UMANG
C) BHIM
D) All of the above

Q439. Email security      में कौन सा तरीका सही है?
Which is a correct email security practice?
A) Sharing password
B) Opening unknown links
C) Strong password & 2FA
D) Ignoring updates

Q440. Social media awareness   का मुख्य उद्देश्य?

Main objective of social media awareness is?
A) Entertainment
B) Safe and responsible usage
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C) Increase addiction
D) Fake news sharing

 True / False Questions (391–400)🔹
441. E-mail electronic communication   का माध्यम है।
442. SMTP incoming mail receive  करता है।
443. Spam mail harmful   हो सकती है।
444. Social networking sites communication    में मदद करते हैं।
445. Cyber bullying  एक cyber crime है।
446. NIC    भारत सरकार की IT agency है।
447. DigiLocker physical documents store  करता है।
448. UMANG app multiple services  देता है।
449. Fake news social media     पर तेजी से फै लती है।

450. Two-factor authentication security  घटाता है।
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Q451. POP3 protocol    की विशेषता क्या है?
What is a feature of POP3 protocol?
A) Mail server   पर रहता है
B) Mail local computer  पर download  होता है
C) Mail encrypt  करता है
D) Spam filter  करता है

Q452. Secure e-mail     के लिए कौन सा protocol   उपयोग होता है?
Which protocol is used for secure e-mail transmission?
A) HTTP
B) HTTPS
C) SMTPS
D) FTP

Q453. E-mail header     में क्या जानकारी होती है?
What information is contained in e-mail header?
A) Sender, Receiver, Subject



 MARATHON CLASS FOR CCC EXAM & OTHER                                                                                                                YORHELP EDUCATION

B) Attachment size only
C) Virus details
D) Advertisement

Q454. Strong password    की पहचान क्या है?
Which defines a strong password?
A) User name
B) Only numbers
C) Mix of letters, numbers & symbols
D) Birth date

Q455.      निम्न में से कौन सा email threat है?
Which of the following is an email threat?
A) Spam
B) Phishing
C) Malware attachment
D) All of the above
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Q456. Social networking  “में Privacy Setting”    का उद्देश्य क्या है?
Purpose of privacy settings in social networking is?
A) Increase followers
B) Control data visibility
C) Increase speed
D) Download videos

Q457. Fake profile       पहचानने का सही तरीका कौन सा है?
Correct way to identify fake profile is?
A) Many unknown friends
B) No profile picture
C) Suspicious activity
D) All of the above

Q458. Social media  पर personal information share   करने का खतरा?
Risk of sharing personal information on social media is?
A) Fame
B) Identity theft
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C) Education
D) Entertainment

Q459. “Digital Footprint”    का अर्थ क्या है?
What is meant by digital footprint?
A) Internet speed
B) Online activity record
C) Computer hardware
D) Network cable

Q460. Social media awareness program  का उद्देश्य?

Objective of social media awareness program is?
A) More users
B) Safe & responsible usage
C) Increase ads
D) Entertainment
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Q461. e-Governance  के G2C    का अर्थ क्या है?
What does G2C stand for in e-Governance?
A) Government to Company
B) Government to Citizen
C) Government to Computer
D) Government to Country

Q462. G2B service     का उदाहरण कौन सा है?
Which is an example of G2B service?
A) Online business registration
B) Online voting
C) Online exam
D) Social networking

Q463. e-Office     प्रणाली का उद्देश्य क्या है?
Purpose of e-Office system is?
A) Paperless office
B) Entertainment
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C) Gaming
D) Advertising

Q464. Government exam portal  का उपयोग?

Use of government exam portal is?
A) Job application & exam
B) Shopping
C) Gaming
D) Blogging

Q465. National Scholarship Portal (NSP)   किससे संबंधित है?
National Scholarship Portal is related to?
A) Health
B) Education & scholarship
C) Transport
D) Agriculture
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Q466. SWAYAM portal  का उद्देश्य?

Objective of SWAYAM portal is?
A) Online shopping
B) Online education
C) Social networking
D) Banking

Q467. DIKSHA platform   किसके लिए है?
DIKSHA platform is meant for?
A) Teachers & students
B) Doctors
C) Farmers
D) Bankers

Q468. CoWIN portal  का उपयोग?

Use of CoWIN portal is?
A) Online exams
B) Vaccination services
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C) Railway booking
D) Banking

Q469. Aarogya Setu App     किस तकनीक पर आधारित है?
Aarogya Setu app is based on which technology?
A) Bluetooth & GPS
B) LAN
C) MAN
D) Cable network

Q470. BharatNet project  का उद्देश्य?

Objective of BharatNet project is?
A) Urban Wi-Fi
B) Broadband connectivity to villages
C) Satellite TV
D) Mobile manufacturing
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Q471. e-Courts project   किससे संबंधित है?
e-Courts project is related to?
A) Banking
B) Judiciary
C) Education
D) Health

Q472. DigiPay      किसके लिए विकसित किया गया है?
DigiPay is developed for?
A) Government employees
B) Rural banking services
C) Online shopping
D) Social media

Q473. CSC     का पूरा नाम क्या है?
Full form of CSC is?
A) Central Service Centre
B) Common Service Centre
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C) Computer Service Centre
D) Citizen Support Cell

Q474. CSC   का मुख्य उद्देश्य?

Main objective of CSC is?
A) Citizen digital services
B) Gaming
C) Advertising
D) Blogging

Q475. mAadhaar App  का उपयोग?

Use of mAadhaar app is?
A) Digital Aadhaar services
B) Banking
C) Education
D) Gaming
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Q476. India Stack   किससे संबंधित है?
India Stack is related to?
A) Digital public infrastructure
B) Hardware manufacturing
C) Social media
D) Gaming

Q477. Open Government Data (OGD) Platform  का उद्देश्य?

Purpose of OGD platform is?
A) Data transparency
B) Data hiding
C) Entertainment
D) Gaming

Q478. AI   का उपयोग e-Governance      में क्यों किया जा रहा है?
Why AI is used in e-Governance?
A) Faster & smart services
B) Increase paperwork



 MARATHON CLASS FOR CCC EXAM & OTHER                                                                                                                YORHELP EDUCATION

C) Reduce transparency
D) Manual work

Q479. Chatbot “MyGov”  का उपयोग?

Use of MyGov chatbot is?
A) Citizen grievance & info
B) Gaming
C) Shopping
D) Blogging

Q480. Cyber awareness   का मुख्य उद्देश्य?

Main objective of cyber awareness is?
A) Fear
B) Safe digital practices
C) Entertainment
D) Speed
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Q481. Email encryption  का लाभ?

Benefit of email encryption is?
A) Faster mail
B) Data security
C) Large attachment
D) Spam removal

Q482. Social engineering attack  क्या है?
What is social engineering attack?
A) Hardware attack
B) Manipulating users to get info
C) Virus scan
D) Backup

Q483. Government “One Nation One Portal”  का उद्देश्य?

Objective of One Nation One Portal is?
A) Single access to services
B) Multiple websites
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C) Social media
D) Gaming

Q484. e-Sign   सेवा का उपयोग?

Use of e-Sign service is?
A) Digital signature
B) Handwritten sign
C) Scanning
D) Printing

Q485. “Exam portal”  का फायदा?
Benefit of exam portal is?
A) Transparency & speed
B) Delay
C) Paper loss
D) Manual work
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Q486. Cyber crime complaint    कहाँ दर्ज होती है?
Where can cyber crime complaint be registered?
A) Police station only
B) cybercrime.gov.in
C) Social media
D) Email

Q487. Social media  पर report option  का उपयोग?

Use of report option on social media?
A) Like post
B) Report abuse/fake content
C) Download video
D) Share post

Q488. Government innovation  का उदाहरण?

Example of government innovation is?
A) DigiLocker
B) CoWIN
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C) UMANG
D) All of the above

Q489. Email  “में Reply All”  का अर्थ?
Meaning of Reply All in email?
A) Only sender
B) All recipients
C) Forward mail
D) Delete mail

Q490. Social networking etiquette  का अर्थ?
Meaning of social networking etiquette is?
A) Online good behavior
B) Password sharing
C) Hacking
D) Fake profile
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 True / False Questions (491–500)🔹

491.POP3 mail  को server  से delete   कर सकता है।
492.Phishing  के वल social media   पर होता है।
493.Privacy settings data protection    में मदद करती हैं।
494.Digital footprint  हमेशा delete    किया जा सकता है।
495.G2C services      नागरिकों  को सीधी सेवा देती हैं।
496.CSC       ग्रामीण क्षेत्रों  में डिजिटल सेवाएँ देता है।
497.DigiLocker legal documents store   कर सकता है।
498.Cyber awareness cyber crime     रोकने में मदद करती है।
499.e-Sign physical signature    से कम सुरक्षित है।
500.Government apps transparency  बढ़ाते हैं।
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 Answer Key with Brief Explanation (PART–1)✅
 MCQs (401–500)🔸

35  B – Electronic Mail1️⃣
35  B – Electronic messages 2️⃣   भेजने के लिए
35  C – SMTP mail 3️⃣  भेजता है
35  B – POP3/IMAP receive 4️⃣  करते हैं
35  B – Mail server 5️⃣   पर रहता है
35  D – 6️⃣  सभी free services हैं
35  A – Carbon Copy7️⃣
35  B – Recipient hide 8️⃣   करने के लिए
35  C – Mail 9️⃣   के साथ file
36  B – Junk mail0️⃣
36  B – Information 1️⃣ चोरी
36  B – Authentication2️⃣
36  B – Extra security3️⃣
36  D – 4️⃣  सभी social sites
36  A – Sharing & networking5️⃣
36  B – LinkedIn professional 6️⃣ है
36  B – Mental stress7️⃣
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36  C – Social media8️⃣
36  B – Online harassment9️⃣
37  A – Electronic governance0️⃣
37  A – Transparency1️⃣
37  C – .gov / .nic.in2️⃣
37  B – National Informatics Centre3️⃣
37  B – Govt IT support4️⃣
37  B – Farmer services5️⃣
37  B – e-District portal6️⃣
37  B – Citizen services7️⃣
37  B – Govt IT institute8️⃣
37  B – MeitY9️⃣
38  A – Ministry of Electronics & IT0️⃣
38  B – Digital storage1️⃣
38  B – Govt services2️⃣
38  B – Health3️⃣
38  B – Digital exams4️⃣
38  B – Hospital services5️⃣
38  B – Mobile governance6️⃣
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38  A – Digital empowerment7️⃣
38  D – All are examples8️⃣
38  C – Strong security9️⃣
39  B – Safe usage0️⃣

 True / False🔸
39  True1️⃣
39  False (SMTP sends)2️⃣
39  True3️⃣
39  True4️⃣
39  True5️⃣
39  True6️⃣
39  False (Digital documents)7️⃣
39  True8️⃣
39  True9️⃣
40  False0️⃣

45  B – Mail local system 1️⃣  पर download
45  C – Secure SMTP2️⃣
45  A – Sender/Receiver info3️⃣
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45  C – Strong password4️⃣
45  D – All are threats5️⃣
45  B – Data control6️⃣
45  D – All indicators7️⃣
45  B – Identity theft8️⃣
45  B – Online activity record9️⃣
46  B – Safe usage0️⃣
46  B – Govt to Citizen1️⃣
46  A – Business services2️⃣
46  A – Paperless office3️⃣
46  A – Exam & jobs4️⃣
46  B – Scholarships5️⃣
46  B – Online learning6️⃣
46  A – Teachers/students7️⃣
46  B – Vaccination8️⃣
46  A – Bluetooth & GPS9️⃣
47  B – Rural broadband0️⃣
47  B – Judiciary1️⃣
47  B – Rural banking2️⃣
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47  B – Common Service Centre3️⃣
47  A – Citizen services4️⃣
47  A – Digital Aadhaar5️⃣
47  A – Digital infra6️⃣
47  A – Transparency7️⃣
47  A – Smart governance8️⃣
47  A – Citizen support9️⃣
48  B – Safe practices0️⃣
48  B – Data security1️⃣
48  B – Human manipulation2️⃣
48  A – Single access3️⃣
48  A – Digital sign4️⃣
48  A – Transparency5️⃣
48  B – cybercrime.gov.in6️⃣
48  B – Report abuse7️⃣
48  D – All8️⃣
48  B – All recipients9️⃣
49  A – Good behavior0️⃣
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 True / False🔸
49  True1️⃣
49  False2️⃣
49  True3️⃣
49  False4️⃣
49  True5️⃣
49  True6️⃣
49  True7️⃣
49  True8️⃣
49  False9️⃣
50  True0️⃣



 MARATHON CLASS FOR CCC EXAM & OTHER                                                                                                                YORHELP EDUCATION

8. Digital Financial Tools and Applications: : 100 MCQs

 Digital Financial Tools & Applications 💳📲

Topics Covered
Biometric, AEPS, BHIM, UPI, Digital Banking, E-Banking, Online Transactions,
Cyber Security, NEFT, RTGS, IMPS, Payment Systems

Q1. Digital Financial Tools    का अर्थ क्या है?
What are Digital Financial Tools?
A) Manual banking tools
B) Cash-based services
C) Technology-based financial services
D) Paper documents

Q2. Biometric authentication   का अर्थ है?
Biometric authentication means?
A) Password based login
B) Fingerprint/iris based identification
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C) OTP only
D) Username based login

Q3.      निम्न में से कौन सा biometric    पहचान का उदाहरण है?
Which is an example of biometric identification?
A) PIN
B) Password
C) Fingerprint
D) Username

Q4. AEPS     का पूरा नाम क्या है?
Full form of AEPS is?
A) Aadhaar Enabled Payment System
B) Advanced Electronic Payment System
C) Automated Electronic Payment Service
D) Aadhaar Easy Payment Service
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Q5. AEPS    किस पर आधारित है?
AEPS is based on?
A) Debit card
B) Credit card
C) Aadhaar number & biometric
D) Mobile number

Q6. AEPS      से कौन सी सेवा मिलती है?
Which service is provided by AEPS?
A) Cash withdrawal
B) Balance enquiry
C) Fund transfer
D) All of the above

Q7. BHIM App      किसके द्वारा विकसित किया गया है?
BHIM App is developed by?
A) RBI
B) NPCI
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C) SBI
D) UIDAI

Q8. BHIM App       का उपयोग किस लिए किया जाता है?
BHIM App is used for?
A) Online shopping
B) UPI based payment
C) Net browsing
D) Email

Q9. UPI     का पूरा नाम क्या है?
Full form of UPI is?
A) Unified Payment Interface
B) Universal Payment Internet
C) Unique Payment Interface
D) United Payment India
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Q10. UPI transaction     के लिए क्या आवश्यक है?
What is required for UPI transaction?
A) IFSC code
B) Debit card number
C) UPI ID & PIN
D) Account number only

Q11.      निम्न में से कौन सा UPI App है?
Which of the following is a UPI app?
A) BHIM
B) Google Pay
C) PhonePe
D) All of the above

Q12. Digital Banking    का अर्थ क्या है?
Meaning of digital banking is?
A) Manual banking
B) Banking through digital channels
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C) Cash banking
D) Offline banking

Q13. Internet Banking        को और किस नाम से जाना जाता है?
Internet banking is also known as?
A) E-Banking
B) M-Banking
C) Core banking
D) Retail banking

Q14. E-Banking    की सुविधा क्या है?
A feature of e-banking is?
A) 24×7 access
B) Paper-based work
C) Long queues
D) Manual ledger
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Q15. Online transaction   का मुख्य लाभ?

Main benefit of online transaction is?
A) Time saving
B) Paper saving
C) Convenience
D) All of the above

Q16. NEFT     का पूरा नाम क्या है?
Full form of NEFT is?
A) National Electronic Fund Transfer
B) National Easy Fund Transfer
C) New Electronic Fund Tool
D) Network Electronic Fund Transfer

Q17. NEFT    किस प्रकार का transfer है?
NEFT is which type of transfer?
A) Real-time
B) Batch-wise
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C) Cash based
D) Card based

Q18. RTGS     का पूरा नाम क्या है?
Full form of RTGS is?
A) Real Time Gross Settlement
B) Rapid Transfer Global System
C) Real Transaction Gross Service
D) Reserve Transfer Gross System

Q19. RTGS    की विशेषता क्या है?
Feature of RTGS is?
A) Low value transfer
B) Real-time transfer
C) Offline transfer
D) Delayed transfer
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Q20. IMPS     का पूरा नाम क्या है?
Full form of IMPS is?
A) Immediate Mobile Payment Service
B) Instant Money Payment Service
C) Immediate Payment Service
D) International Money Payment System

Q21. IMPS      की सुविधा कब उपलब्ध होती है?
IMPS service is available?
A) Office hours only
B) Bank hours only
C) 24×7
D) Weekdays only

Q22.      निम्न में से कौन सा instant payment system है?
Which is an instant payment system?
A) NEFT
B) RTGS
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C) IMPS
D) Cheque

Q23. Cyber security    का अर्थ क्या है?
Meaning of cyber security is?
A) Computer repair
B) Protection of digital systems
C) Software installation
D) Internet speed

Q24. Online fraud     का उदाहरण कौन सा है?
Which is an example of online fraud?
A) Phishing
B) OTP fraud
C) Fake UPI request
D) All of the above
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Q25. OTP     का पूरा नाम क्या है?
Full form of OTP is?
A) One Time Password
B) Online Transfer Pin
C) One Transaction Process
D) Official Transfer Password

Q26. OTP      का उपयोग क्यों किया जाता है?
Why OTP is used?
A) Decoration
B) Extra security
C) Speed increase
D) Data storage

Q27. Digital Wallet     का उदाहरण कौन सा है?
Which is an example of digital wallet?
A) Paytm
B) PhonePe
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C) Amazon Pay
D) All of the above

Q28. Mobile Banking    का उपयोग किस device   से होता है?
Mobile banking is done using?
A) Desktop only
B) ATM
C) Smartphone
D) Printer

Q29. KYC     का पूरा नाम क्या है?
Full form of KYC is?
A) Know Your Customer
B) Keep Your Cash
C) Know Your Card
D) Keep Your Credit
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Q30. KYC    का उद्देश्य क्या है?
Purpose of KYC is?
A) Customer identification
B) Increase profit
C) Speed transaction
D) Marketing

Q31. Digital payment  में PIN  का कार्य?
Role of PIN in digital payment is?
A) Identification
B) Security
C) Authentication
D) All of the above

Q32. QR code       का उपयोग किस लिए किया जाता है?
QR code is used for?
A) Payment scanning
B) Printing
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C) Typing
D) Storage

Q33. Contactless payment     किस तकनीक पर आधारित है?
Contactless payment is based on?
A) NFC
B) LAN
C) MAN
D) Bluetooth only

Q34. Digital banking   का एक नुकसान?

One disadvantage of digital banking is?
A) Cyber risk
B) Time saving
C) Convenience
D) Transparency
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Q35. Two-factor authentication     में क्या शामिल होता है?
Two-factor authentication includes?
A) Password only
B) OTP only
C) Password + OTP
D) Username only

Q36. Online banking  में strong password   कै सा होना चाहिए?

Strong password should be?
A) Simple
B) Common
C) Complex
D) Name based

Q37. Bank fraud    की रिपोर्ट कहाँ करें?
Where to report bank fraud?
A) Social media
B) cybercrime.gov.in
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C) Gaming site
D) Email only

Q38. NPCI     का पूरा नाम क्या है?
Full form of NPCI is?
A) National Payments Corporation of India
B) National Public Credit Institution
C) National Payment Council of India
D) National Private Credit India

Q39. NPCI    का कार्य क्या है?
Function of NPCI is?
A) Payment systems management
B) Education
C) Healthcare
D) Transport
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Q40. Digital India initiative   का एक उद्देश्य?

One objective of Digital India is?
A) Cashless economy
B) Paper work
C) Manual system
D) Offline banking

Q41. Online transaction  “में Fail”     होने पर क्या करना चाहिए?

If online transaction fails, what should you do?
A) Panic
B) Share OTP
C) Wait & check bank status
D) Ignore

Q42. Bank     कभी भी क्या नहीं  पूछता?
What does a bank never ask?
A) OTP
B) PIN
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C) Password
D) All of the above

Q43. Secure website    की पहचान कै से करें?
How to identify secure website?
A) http
B) https
C) www only
D) .com only

Q44. Digital receipt  का लाभ?

Benefit of digital receipt is?
A) Proof of transaction
B) Easy storage
C) Eco-friendly
D) All of the above
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Q45. Cashless payment  का लाभ?

Benefit of cashless payment is?
A) Transparency
B) Safety
C) Convenience
D) All of the above

Q46. Online transaction  में minimum risk  कै से रखें?
How to minimize risk in online transaction?
A) Public Wi-Fi use
B) Share details
C) Use secure network
D) Ignore updates

Q47. Digital banking  “में Logout”   क्यों जरूरी है?
Why is logout important in digital banking?
A) Speed
B) Security
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C) Storage
D) Design

Q48. SMS alert  का उपयोग?

Use of SMS alert is?
A) Promotion
B) Transaction notification
C) Advertisement
D) Entertainment

Q49. Online payment  “में Refund”  का अर्थ?
Meaning of refund in online payment is?
A) Extra payment
B) Return of money
C) Fee
D) Penalty
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Q50. Financial literacy  का अर्थ?
Meaning of financial literacy is?
A) Computer knowledge
B) Financial awareness
C) Banking job
D) Online shopping

 True / False (91–95)🔹
91.UPI transaction  में IFSC code   जरूरी नहीं  होता।
92.RTGS  के वल low value transactions   के लिए है।
93.IMPS 24×7  उपलब्ध है।
94.OTP share   करना सुरक्षित है।
95.Cyber security digital transactions   में जरूरी है।

1.Q51. AEPS       सेवा का लाभ किसे अधिक होता है?
AEPS service is most beneficial for?
A) Urban users
B) Rural & unbanked people
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C) Software developers
D) Bank managers

Q52. AEPS transaction        के लिए कौन सी जानकारी आवश्यक नहीं  है?
Which is NOT required for AEPS transaction?
A) Aadhaar number
B) Biometric
C) ATM card
D) Bank name

Q53. BHIM App  किस payment system   पर आधारित है?
BHIM app is based on which payment system?
A) NEFT
B) RTGS
C) UPI
D) IMPS
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Q54. UPI transaction   की सीमा (limit)     किस पर निर्भर करती है?
UPI transaction limit depends on?
A) Mobile brand
B) Bank policy
C) Internet speed
D) App color

Q55. UPI  “में Collect Request”    का अर्थ क्या है?
Meaning of Collect Request in UPI is?
A) Sending money
B) Requesting money
C) Cash withdrawal
D) Balance enquiry

Q56. Digital Banking  “में Net Banking”      का उपयोग किसके लिए होता है?
Net banking is used for?
A) Fund transfer
B) Bill payment
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C) Account services
D) All of the above

Q57. E-Banking  “में Session Timeout”   क्यों होता है?
Why does session timeout occur in e-banking?
A) Slow internet
B) Security purpose
C) App error
D) Bank holiday

Q58. Online transaction  “में Chargeback”  क्या है?
What is chargeback in online transaction?
A) Extra charge
B) Refund process
C) Penalty
D) Discount
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Q59. NEFT transaction  कब settle  होता है?
When is NEFT transaction settled?
A) Immediately
B) In batches
C) Monthly
D) Yearly

Q60. RTGS transaction        के लिए सामान्यतः न्यूनतम राशि कितनी होती है?
Minimum amount for RTGS transaction is usually?
A) 1,000₹
B) 10,000₹
C) 2 lakh₹
D) 5 lakh₹

Q61. IMPS transaction     के लिए क्या आवश्यक है?
What is required for IMPS transaction?
A) IFSC only
B) Mobile number/MMID or account details
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C) Cheque book
D) Aadhaar only

Q62. Digital Wallet      में पैसा कै से जोड़ा जाता है?
How is money added to a digital wallet?
A) Bank account/debit card
B) Cash only
C) Cheque
D) Demand draft

Q63. Prepaid Payment Instrument (PPI)     का उदाहरण कौन सा है?
Which is an example of PPI?
A) Credit card
B) Debit card
C) Digital wallet
D) Passbook
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Q64. QR code based payment   का मुख्य लाभ?

Main advantage of QR based payment is?
A) No cash handling
B) Quick & easy
C) Low cost
D) All of the above

Q65. Contactless card payment  में PIN    कब जरूरी होता है?
When is PIN required in contactless card payment?
A) Every time
B) Never
C) Above prescribed limit
D) On weekends

Q66. Cyber attack     का उद्देश्य क्या होता है?
Purpose of cyber attack is?
A) Data theft
B) Financial loss
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C) System damage
D) All of the above

Q67. Malware    का अर्थ क्या है?
What is malware?
A) Useful software
B) Harmful software
C) Banking app
D) Antivirus

Q68. Ransomware   क्या करता है?
What does ransomware do?
A) Speed up system
B) Encrypt data & demand ransom
C) Backup files
D) Protect system
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Q69. Online banking  में public Wi-Fi      का उपयोग क्यों नहीं  करना चाहिए?

Why should public Wi-Fi be avoided in online banking?
A) Slow speed
B) Security risk
C) Limited data
D) Battery drain

Q70. “Man-in-the-Middle” attack  क्या है?
What is Man-in-the-Middle attack?
A) Hardware failure
B) Intercepting communication
C) Virus scan
D) Backup process

Q71. Payment Gateway    का कार्य क्या है?
Function of payment gateway is?
A) Connect merchant & bank
B) Store cash
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C) Issue cards
D) Open accounts

Q72. Online shopping  “में Secure Payment”  का संके त?

Sign of secure payment in online shopping is?
A) http
B) https & padlock icon
C) Pop-up ads
D) Free offers

Q73. Digital transaction  “में Failed but debited”    का क्या अर्थ है?
Meaning of “Failed but debited” is?
A) Successful payment
B) Money deducted but not credited
C) Cashback
D) Extra charge
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Q74. Failed transaction         में पैसा सामान्यतः कितने दिनों  में वापस आता है?
Refund in failed transaction usually comes in?
A) Same day
B) 1–3 working days
C) 5–7 working days
D) 30 days

Q75. Cyber crime helpline number  क्या है?
Cyber crime helpline number is?
A) 100
B) 112
C) 1930
D) 1091

Q76. AEPS transaction     कहाँ किया जा सकता है?
Where can AEPS transaction be done?
A) Bank branch only
B) ATM only
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C) CSC / Banking correspondent
D) Mobile recharge shop

Q77. Digital banking  “में Auto-debit”  का अर्थ?
Meaning of auto-debit in digital banking is?
A) Manual payment
B) Automatic payment
C) Cash payment
D) Cheque payment

Q78. Online transaction  का record   कहाँ मिलता है?
Where is record of online transaction available?
A) Passbook only
B) Bank statement/app
C) ATM slip
D) Cheque
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Q79. Virtual Debit Card  का उपयोग?

Use of virtual debit card is?
A) ATM withdrawal
B) Online transactions
C) Cash deposit
D) Cheque issue

Q80. Tokenization       का उपयोग किस लिए किया जाता है?
Tokenization is used for?
A) Speed increase
B) Card data security
C) Marketing
D) Advertisement

Q81. Digital payment system  को regulate   कौन करता है?
Who regulates digital payment system in India?
A) SEBI
B) RBI
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C) TRAI
D) UIDAI

Q82. RBI     का पूरा नाम क्या है?
Full form of RBI is?
A) Reserve Bank of India
B) Regional Bank of India
C) Royal Bank of India
D) Retail Bank of India

Q83. Cashless economy  का लाभ?

Benefit of cashless economy is?
A) Transparency
B) Reduced corruption
C) Convenience
D) All of the above
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Q84. Digital payment  “में Reversal”  का अर्थ?
Meaning of reversal in digital payment is?
A) Payment retry
B) Refund of failed transaction
C) Penalty
D) Discount

Q85. Banking fraud     से बचने का सही तरीका?
Correct way to avoid banking fraud is?
A) Sharing OTP
B) Ignoring alerts
C) Awareness & caution
D) Using public Wi-Fi

Q86. Digital literacy  का अर्थ?
Meaning of digital literacy is?
A) Reading books
B) Using digital tools safely
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C) Only typing
D) Playing games

Q87. Online banking  “में Beneficiary”   कौन होता है?
Who is beneficiary in online banking?
A) Bank
B) Sender
C) Receiver
D) App

Q88. IMPS      में पैसा कितनी देर में transfer  होता है?
How fast is money transferred in IMPS?
A) Few seconds
B) Few hours
C) Next day
D) Weekly



 MARATHON CLASS FOR CCC EXAM & OTHER                                                                                                                YORHELP EDUCATION

Q89. Digital transaction     के लिए सबसे सुरक्षित तरीका?
Safest method for digital transaction is?
A) Sharing details
B) Using secure apps & 2FA
C) Public computer
D) Weak password

Q90. Financial fraud      होने पर सबसे पहले क्या करें?
What should be done first in case of financial fraud?
A) Ignore
B) Share details online
C) Inform bank & report
D) Close account

Q91. Micro-ATM     का उपयोग किससे संबंधित है?
Micro-ATM is related to?
A) Gaming
B) AEPS & banking services
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C) Education
D) Transport

Q92. Offline digital payment  का उदाहरण?

Example of offline digital payment is?
A) UPI online
B) NFC based payment
C) Net banking
D) NEFT

Q93. Sound-based UPI      का उपयोग किस लिए किया गया?
Sound-based UPI is used for?
A) Faster internet
B) Low connectivity areas
C) Gaming
D) Video calling
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Q94. CBDC     का पूरा नाम क्या है?
Full form of CBDC is?
A) Central Bank Digital Currency
B) Commercial Bank Digital Cash
C) Computer Based Digital Coin
D) Central Blockchain Digital Coin

Q95. Digital Rupee      किसके द्वारा जारी की जाती है?
Digital Rupee is issued by?
A) NPCI
B) RBI
C) SBI
D) Government portal

Q96. Biometric authentication   का एक जोखिम?

One risk of biometric authentication is?
A) Easy duplication
B) Data misuse if compromised
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C) Slow internet
D) High cost

Q97. Online banking  में antivirus     का उपयोग क्यों जरूरी है?
Why is antivirus important in online banking?
A) Speed
B) Protection from malware
C) Storage
D) Design

Q98. Digital payment  “में Settlement”  का अर्थ?
Meaning of settlement in digital payment is?
A) Initiation
B) Final credit to account
C) Refund
D) Delay
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Q99. UPI PIN      भूल जाने पर क्या करना चाहिए?

If UPI PIN is forgotten, what should be done?
A) Share details
B) Reset PIN securely
C) Stop using app
D) Use same PIN

Q100. Digital Financial Tools    का सबसे बड़ा लाभ?

Biggest advantage of digital financial tools is?
A) Speed & convenience
B) Paper work
C) Manual effort
D) Limited access

 True / False Questions (96–105)🔹

96.AEPS  में biometric authentication  आवश्यक है।
97.NEFT  के वल working hours    में उपलब्ध होता है।
98.RTGS high value transactions     के लिए उपयोग होता है।
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99.Public Wi-Fi  पर banking  सुरक्षित है।
100.Cyber awareness fraud      कम करने में मदद करती है।
101.IMPS real-time payment system है।
102.Digital wallet  में KYC   जरूरी नहीं  होती।
103.RBI digital payments  को regulate  करता है।
104.Tokenization card data    को सुरक्षित बनाता है।
105.Digital Rupee    एक प्रकार की cryptocurrency है।
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 Answer Key with Brief Explanation (PART–1)✅
MCQs:

 C – Technology based finance1️⃣
 B – Biometric ID2️⃣
 C – Fingerprint3️⃣
 A – AEPS4️⃣
 C – Aadhaar + biometric5️⃣
 D – All services6️⃣
 B – NPCI7️⃣
 B – UPI payment8️⃣
 A – Unified Payment Interface9️⃣
 C – UPI ID & PIN🔟

1  D – All apps1️⃣
1  B – Digital channels2️⃣
1  A – E-Banking3️⃣
1  A – 24×74️⃣
1  D – All benefits5️⃣
1  A – NEFT6️⃣
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1  B – Batch transfer7️⃣
1  A – RTGS8️⃣
1  B – Real-time9️⃣
2  C – IMPS0️⃣
2  C – 24×71️⃣
2  C – IMPS2️⃣
2  B – Protection3️⃣
2  D – All frauds4️⃣
2  A – OTP5️⃣
2  B – Security6️⃣
2  D – All wallets7️⃣
2  C – Smartphone8️⃣
2  A – Know Your Customer9️⃣
3  A – Identification0️⃣
3  D – All1️⃣
3  A – Payment scan2️⃣
3  A – NFC3️⃣
3  A – Cyber risk4️⃣
3  C – Password + OTP5️⃣
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3  C – Complex6️⃣
3  B – cybercrime.gov.in7️⃣
3  A – NPCI8️⃣
3  A – Payment systems9️⃣
4  A – Cashless economy0️⃣
4  C – Wait & check1️⃣
4  D – Never ask2️⃣
4  B – https3️⃣
4  D – All4️⃣
4  D – All5️⃣
4  C – Secure network6️⃣
4  B – Security7️⃣
4  B – Alerts8️⃣
4  B – Money return9️⃣
5  B – Awareness0️⃣
True/False:
9  True1️⃣
9  False2️⃣
9  True3️⃣
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9  False4️⃣
9  True5️⃣

 Answer Key with Brief Explanation (PART–2)✅
MCQs (51–100):

5  B – Rural/unbanked1️⃣
5  C – ATM card 2️⃣  नहीं  चाहिए
5  C – UPI3️⃣
5  B – Bank policy4️⃣
5  B – Money request5️⃣
5  D – All6️⃣
5  B – Security7️⃣
5  B – Refund process8️⃣
5  B – Batch wise9️⃣
6  C – 2 lakh0️⃣₹0️⃣
6  B – Mobile/MMID or account1️⃣
6  A – Bank/debit card2️⃣
6  C – Digital wallet3️⃣
6  D – All benefits4️⃣
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6  C – Above limit5️⃣
6  D – All6️⃣
6  B – Harmful software7️⃣
6  B – Encrypt & ransom8️⃣
6  B – Security risk9️⃣
7  B – Intercepting data0️⃣
7  A – Connects systems1️⃣
7  B – https & lock2️⃣
7  B – Deducted not credited3️⃣
7  C – 5–7 days4️⃣
7  C – 19305️⃣
7  C – CSC/BC6️⃣
7  B – Automatic payment7️⃣
7  B – Statement/app8️⃣
7  B – Online use9️⃣
8  B – Card security0️⃣
8  B – RBI1️⃣
8  A – Reserve Bank2️⃣
8  D – All3️⃣
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8  B – Refund4️⃣
8  C – Awareness5️⃣
8  B – Safe use6️⃣
8  C – Receiver7️⃣
8  A – Seconds8️⃣
8  B – Secure apps + 2FA9️⃣
9  C – Inform & report0️⃣
9  B – AEPS1️⃣
9  B – NFC2️⃣
9  B – Low connectivity3️⃣
9  A – Central Bank Digital Currency4️⃣
9  B – RBI5️⃣
9  B – Data misuse risk6️⃣
9  B – Malware protection7️⃣
9  B – Final credit8️⃣
9  B – Reset PIN9️⃣
10  A – Speed & convenience0️⃣
True / False:
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9  True6️⃣
9  False (24×7 available now)7️⃣
9  True8️⃣
9  False9️⃣
10  True0️⃣
10  True1️⃣
10  False2️⃣
10  True3️⃣
10  True4️⃣
10  False (CBDC ≠ crypto)5️⃣
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9.  Overview of Future Skills & Cyber Security 🚀🔐 : 100 MCQs 

Q1. Artificial Intelligence (AI)    का अर्थ क्या है?
What is the meaning of Artificial Intelligence?
A) Natural thinking
B) Human-like intelligence in machines
C) Only robotics
D) Internet technology

Q2. AI       का उपयोग किस क्षेत्र में नहीं  होता?
AI is NOT used in which field?
A) Healthcare
B) Education
C) Agriculture
D) Manual handwriting

Q3. Machine Learning  क्या है?
What is Machine Learning?
A) Programming manually
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B) Learning by machines from data
C) Hardware repairing
D) Network cabling

Q4. Machine Learning  किस AI   का उपक्षेत्र है?
Machine Learning is a subset of?
A) Networking
B) Artificial Intelligence
C) Cyber Law
D) Database

Q5. Deep Learning    किस पर आधारित है?
Deep Learning is based on?
A) Flowcharts
B) Neural Networks
C) HTML
D) Compiler
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Q6. AI     का उदाहरण कौन सा है?
Which is an example of AI?
A) Calculator
B) Chatbot
C) Printer
D) Scanner

Q7. ChatGPT     किस तकनीक पर आधारित है?
ChatGPT is based on which technology?
A) AR
B) Machine Learning & NLP
C) Blockchain
D) Cloud storage

Q8. Natural Language Processing (NLP)  का उपयोग?

Use of NLP is?
A) Image printing
B) Understanding human language
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C) Cable connection
D) Virus removal

Q9. AR     का पूरा नाम क्या है?
Full form of AR is?
A) Artificial Reality
B) Augmented Reality
C) Advanced Robotics
D) Automated Reality

Q10. VR     का पूरा नाम क्या है?
Full form of VR is?
A) Virtual Reality
B) Visual Resource
C) Verified Reality
D) Virtual Record
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Q11. Augmented Reality  का उदाहरण?

Example of Augmented Reality is?
A) Google Lens
B) MS Word
C) Calculator
D) Notepad

Q12. Virtual Reality     का उपयोग कहाँ होता है?
VR is used in?
A) Gaming & training
B) Typing
C) Printing
D) Email

Q13. Metaverse     किस तकनीक का मिश्रण है?
Metaverse is a combination of?
A) AR + VR + AI
B) Email + Browser
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C) OS + Hardware
D) Antivirus

Q14. Meta AI     किस कं पनी से संबंधित है?
Meta AI belongs to which company?
A) Google
B) Microsoft
C) Meta (Facebook)
D) Amazon

Q15. WhatsApp AI     का उपयोग किसलिए होता है?
WhatsApp AI is used for?
A) Automatic replies & assistance
B) Virus removal
C) Formatting text
D) Printing
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Q16. AI Tools     का उदाहरण कौन सा है?
Which is an AI tool?
A) ChatGPT
B) MS Paint
C) VLC Player
D) WinRAR

Q17. AI  आधारित Image Generation tool?

AI-based image generation tool is?
A) DALL·E
B) Excel
C) PowerPoint
D) Notepad

Q18.    भविष्य के कौशल (Future Skills)     में कौन सा शामिल है?
Which is included in Future Skills?
A) Typewriting
B) AI & Data Analysis
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C) Paper filing
D) Manual accounting

Q19. Data Science   का मुख्य कार्य?
Main task of Data Science is?
A) Data analysis & insights
B) Data printing
C) Data typing
D) Data deletion

Q20. Cloud Computing  का अर्थ?
Meaning of Cloud Computing is?
A) Storing data on internet servers
B) Using clouds
C) Offline storage
D) Pen drive
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 Cyber Security Section🔐
Q21. Cyber Security    का उद्देश्य क्या है?
Purpose of Cyber Security is?
A) Entertainment
B) Protect systems & data
C) Slow network
D) Formatting

Q22. Cyber attack  का उदाहरण?

Example of cyber attack is?
A) Phishing
B) Typing
C) Printing
D) Scanning

Q23. Phishing attack  का उद्देश्य?

Purpose of phishing attack is?
A) Data backup
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B) Stealing personal information
C) Antivirus update
D) Speed increase

Q24. Malware  क्या है?
What is malware?
A) Useful software
B) Harmful software
C) Operating system
D) Driver

Q25. Ransomware   क्या करता है?
What does ransomware do?
A) Deletes data
B) Encrypts data & demands money
C) Repairs system
D) Speeds up PC
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Q26. Firewall  का उपयोग?

Use of firewall is?
A) Virus creation
B) Network security
C) File compression
D) Printing

Q27. Antivirus software  का कार्य?
Function of antivirus software is?
A) Detect & remove malware
B) Create virus
C) Edit documents
D) Manage files

Q28. Strong password    में क्या होना चाहिए?

Strong password should include?
A) Only numbers
B) Letters, numbers & symbols
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C) Name only
D) Date of birth

Q29. Two-Factor Authentication (2FA)  क्या है?
What is 2FA?
A) Double typing
B) Two-level security
C) Two accounts
D) Two browsers

Q30. Cyber Cell  क्या है?
What is Cyber Cell?
A) Computer lab
B) Cyber crime investigation unit
C) Internet café
D) Software company
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Q31.   भारत में cyber crime helpline number?

Cyber crime helpline number in India is?
A) 100
B) 112
C) 1930
D) 1098

Q32. Cyber Law   किससे संबंधित है?
Cyber Law is related to?
A) Road safety
B) Internet & digital crimes
C) Banking only
D) Hardware

Q33. IT Act 2000    किस देश का cyber law है?
IT Act 2000 belongs to which country?
A) USA
B) UK
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C) India
D) Japan

Q34. Cyber bullying  का अर्थ?
Meaning of cyber bullying is?
A) Online harassment
B) Online shopping
C) Email sending
D) Video calling

Q35. Social media  पर privacy   क्यों जरूरी है?
Why is privacy important on social media?
A) Fun
B) Data protection
C) Speed
D) Likes
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 Current GK & Awareness📅
Q36. Computer Literacy Day    कब मनाया जाता है?
Computer Literacy Day is celebrated on?
A) 2 October
B) 2 December
C) 26 January
D) 15 August

Q37. Safer Internet Day    कब मनाया जाता है?
Safer Internet Day is observed on?
A) February (2nd Tuesday)
B) January 1
C) March 8
D) April 7

Q38. Digital India Mission  का उद्देश्य?

Objective of Digital India Mission is?
A) Digital empowerment
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B) Manual work
C) Paper system
D) Offline services

Q39. AI ethics  का अर्थ?
Meaning of AI ethics is?
A) AI marketing
B) Responsible use of AI
C) AI coding
D) AI hacking

Q40.     भविष्य में सबसे अधिक demand  वाला skill?

Most demanded future skill is?
A) AI & Cyber Security
B) Typewriting
C) Fax handling
D) Photocopy
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Q41. Robotics     किस तकनीक से संबंधित है?
Robotics is related to which technology?
A) Artificial Intelligence
B) Database
C) Networking only
D) Spreadsheet

Q42. Automation     का मुख्य उद्देश्य क्या है?
Main objective of automation is?
A) Increase manual work
B) Reduce human effort & errors
C) Increase paperwork
D) Slow process

Q43. Industry 4.0   किससे संबंधित है?
Industry 4.0 is related to?
A) Traditional farming
B) Smart manufacturing & automation
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C) Typewriting
D) Printing

Q44. Internet of Things (IoT)    का अर्थ क्या है?
Meaning of IoT is?
A) Network of connected smart devices
B) Internet speed
C) Email service
D) Website design

Q45. Smart Home     किस तकनीक पर आधारित है?
Smart Home is based on?
A) IoT
B) Only AI
C) Compiler
D) Antivirus



 MARATHON CLASS FOR CCC EXAM & OTHER                                                                                                                YORHELP EDUCATION

Q46. AI   का उपयोग Agriculture    में कै से होता है?
How is AI used in agriculture?
A) Crop monitoring & prediction
B) Typing reports
C) Printing bills
D) Data entry

Q47. Face Recognition     किस तकनीक का उदाहरण है?
Face recognition is an example of?
A) Computer Vision
B) Spreadsheet
C) Word processing
D) Firewall

Q48. Computer Vision     का उपयोग किसमें होता है?
Computer Vision is used in?
A) Image & video analysis
B) Audio recording



 MARATHON CLASS FOR CCC EXAM & OTHER                                                                                                                YORHELP EDUCATION

C) Text typing
D) File compression

Q49. AI  आधारित Voice Assistant  का उदाहरण?

Example of AI-based voice assistant is?
A) Alexa
B) Calculator
C) Paint
D) Notepad

Q50.     भविष्य में कौन सा job   सबसे अधिक demand  में है?
Which job is most in demand in future?
A) Data Scientist
B) Typewriter
C) File clerk
D) Fax operator
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Q51. Ethical AI    का अर्थ क्या है?
Meaning of Ethical AI is?
A) Illegal use of AI
B) Responsible & fair use of AI
C) AI hacking
D) AI marketing

Q52. Bias in AI      का कारण क्या हो सकता है?
What can cause bias in AI?
A) Poor quality data
B) Antivirus
C) Printer
D) Scanner

Q53. Explainable AI (XAI)  का उद्देश्य?

Purpose of Explainable AI is?
A) Hide decisions
B) Make AI decisions understandable
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C) Slow system
D) Increase cost

Q54. Cyber Hygiene  का अर्थ?
Meaning of Cyber Hygiene is?
A) Cleaning computer
B) Safe online practices
C) Internet speed
D) Hardware repair

Q55. Social Engineering attack  क्या है?
What is social engineering attack?
A) Technical hacking
B) Manipulating people to get information
C) Hardware failure
D) Software update
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Q56. Identity Theft  का अर्थ?
Meaning of Identity Theft is?
A) Losing ID card
B) Stealing personal identity online
C) Deleting account
D) Password reset

Q57. Cyber Crime Portal        भारत सरकार द्वारा किस उद्देश्य से बनाया गया?
Cyber Crime Portal is created for?
A) Online shopping
B) Reporting cyber crimes
C) Entertainment
D) Education only

Q58. https      का उपयोग क्यों किया जाता है?
Why is https used?
A) Faster website
B) Secure communication
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C) More ads
D) Free content

Q59. Encryption     का उपयोग किसलिए होता है?
Encryption is used for?
A) Data security
B) File deletion
C) Virus creation
D) Formatting

Q60. Decryption  का अर्थ?
Meaning of decryption is?
A) Encrypt data
B) Convert encrypted data to original form
C) Delete data
D) Compress data
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Q61. Zero Trust Security Model  का सिद्धांत?

Principle of Zero Trust Model is?
A) Trust everyone
B) Never trust, always verify
C) No security
D) Free access

Q62. Cyber Forensics     का उपयोग किसमें होता है?
Cyber forensics is used in?
A) Crime investigation
B) Website design
C) Gaming
D) Accounting

Q63. Digital Footprint  क्या है?
What is digital footprint?
A) Physical footprint
B) Online activity record
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C) Virus
D) Hardware damage

Q64. AI  आधारित Recommendation System  का उदाहरण?

Example of AI recommendation system is?
A) YouTube suggestions
B) Calculator
C) Notepad
D) Paint

Q65. Fake News    पहचानने का सही तरीका?
Correct way to identify fake news is?
A) Forward immediately
B) Verify from reliable sources
C) Believe blindly
D) Ignore facts
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Q66. Deepfake technology   किससे संबंधित है?
Deepfake technology is related to?
A) Fake images/videos using AI
B) Text editing
C) Printing
D) Networking

Q67. Cyber Awareness  का उद्देश्य?

Purpose of cyber awareness is?
A) Increase fraud
B) Reduce cyber crimes
C) Slow internet
D) Promote hacking

Q68. AI in Education  का लाभ?

Benefit of AI in education is?
A) Personalized learning
B) More paperwork
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C) Manual checking
D) Slow evaluation

Q69. Smart City       में कौन सी तकनीक उपयोग होती है?
Which technology is used in Smart City?
A) IoT & AI
B) Typewriter
C) Manual register
D) Fax

Q70. Robotics Process Automation (RPA)  का उपयोग?

Use of RPA is?
A) Automate repetitive tasks
B) Virus removal
C) Web browsing
D) Gaming
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Q71. Cyber Terrorism  का उद्देश्य?

Objective of cyber terrorism is?
A) Entertainment
B) Create fear & damage systems
C) Education
D) Banking only

Q72. Data Privacy  का अर्थ?
Meaning of data privacy is?
A) Sharing data
B) Protecting personal information
C) Data deletion
D) Data selling

Q73. AI  आधारित Fraud Detection     का उपयोग कहाँ होता है?
AI-based fraud detection is used in?
A) Banking & finance
B) Printing
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C) Typing
D) Gaming

Q74. Quantum Computing     भविष्य में क्यों महत्वपूर्ण है?
Why is quantum computing important in future?
A) Very high processing power
B) Typing speed
C) Printing quality
D) Screen size

Q75. Blockchain technology  का उपयोग?

Use of blockchain technology is?
A) Secure & transparent transactions
B) Image editing
C) Video playing
D) Antivirus
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Q76. AI Governance  का अर्थ?
Meaning of AI governance is?
A) AI marketing
B) Rules & policies for AI use
C) AI hacking
D) AI gaming

Q77. Digital Divide  का अर्थ?
Meaning of digital divide is?
A) Computer virus
B) Gap in digital access
C) Network error
D) Software bug

Q78. Cyber Safety tips    में क्या शामिल है?
What is included in cyber safety tips?
A) Sharing OTP
B) Regular password update
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C) Using weak password
D) Ignoring updates

Q79. AI  आधारित Health Care  का उदाहरण?

Example of AI in healthcare is?
A) Disease prediction
B) File typing
C) Manual report
D) Printing

Q80.   भारत में Digital Skill development     किस मिशन से जुड़ा है?
Digital skill development in India is related to?
A) Skill India
B) Make in India
C) Swachh Bharat
D) Khelo India
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Q81. Cyber Crime       शिकायत ऑनलाइन कहाँ की जा सकती है?
Cyber crime complaint can be filed at?
A) cybercrime.gov.in
B) irctc.co.in
C) uidai.gov.in
D) india.gov.in

Q82. AI  आधारित Translation tool  का उदाहरण?

Example of AI-based translation tool is?
A) Google Translate
B) Calculator
C) Paint
D) Explorer

Q83. Metaverse      का उपयोग भविष्य में कहाँ होगा?
Metaverse will be used in?
A) Education & meetings
B) Only gaming
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C) Printing
D) File storage

Q84. Cyber Ethics  का अर्थ?
Meaning of cyber ethics is?
A) Hacking rules
B) Moral use of technology
C) Virus writing
D) Cyber crime

Q85. AI  आधारित Chatbot  का उपयोग?

Use of AI-based chatbot is?
A) Customer support
B) Hardware repair
C) Network wiring
D) Data printing
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Q86. Digital Signature  का उपयोग?

Use of digital signature is?
A) Document authentication
B) Virus scan
C) Formatting
D) Backup

Q87. Cyber Security  में CIA Triad  का अर्थ?
CIA triad stands for?
A) Confidentiality, Integrity, Availability
B) Cyber, Internet, Access
C) Code, Input, Output
D) Control, Inspect, Allow

Q88. AI  आधारित Smart Assistant  का उदाहरण?

Example of smart assistant is?
A) Siri
B) Excel
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C) WinZip
D) Notepad

Q89. AI       भविष्य में किस प्रकार की नौकरियाँ बढ़ाएगा?
AI will increase which type of jobs?
A) New tech-based jobs
B) Manual filing
C) Fax operation
D) Typewriting

Q90. Cyber Security Awareness Month    कब मनाया जाता है?
Cyber Security Awareness Month is observed in?
A) October
B) January
C) March
D) July
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Q91. AI  आधारित Autonomous Vehicle      किस तकनीक पर काम करता है?
Autonomous vehicles work on?
A) AI + Sensors
B) Only engine
C) Printer
D) Scanner

Q92. Digital Resilience  का अर्थ?
Meaning of digital resilience is?
A) No backup
B) Ability to recover from cyber attacks
C) Slow system
D) Manual work

Q93. AI  आधारित Content Creation  का उदाहरण?

Example of AI-based content creation is?
A) Text/image generation tools
B) Manual typing
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C) Printing
D) Scanning

Q94. Cyber Risk Assessment  का उद्देश्य?

Purpose of cyber risk assessment is?
A) Identify threats & vulnerabilities
B) Create virus
C) Reduce internet
D) Increase cost

Q95. Future Skills    में कौन सा skill   सबसे जरूरी है?
Most important future skill is?
A) Continuous learning
B) Memorization only
C) Manual copying
D) Paper filing
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Q96. AI  आधारित Speech Recognition  का उपयोग?

Use of speech recognition is?
A) Voice to text
B) Image editing
C) File deletion
D) Printing

Q97. Cyber Crime      से बचने का सबसे अच्छा तरीका?
Best way to avoid cyber crime is?
A) Ignorance
B) Awareness & caution
C) Sharing details
D) Weak security

Q98. Digital Ethics  का अर्थ?
Meaning of digital ethics is?
A) Illegal activities
B) Responsible use of digital tech
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C) Hacking
D) Piracy

Q99. AI  आधारित Predictive Analytics  का उपयोग?

Use of predictive analytics is?
A) Forecasting future trends
B) Typing
C) Printing
D) Gaming

Q100. Future Skills & Cyber Security    पढ़ने का मुख्य उद्देश्य?

Main objective of learning future skills & cyber security is?
A) Safe & smart digital life
B) Only exams
C) Entertainment
D) Time pass
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 ✅Answer Key (1–100) with Brief Explanation Future Skills 
 B – Machines with human-like intelligence1️⃣
 D – Manual handwriting2️⃣
 B – Learning from data3️⃣
 B – Subset of AI4️⃣
 B – Neural networks5️⃣
 B – Chatbot6️⃣
 B – ML + NLP7️⃣
 B – Language understanding8️⃣
 B – Augmented Reality9️⃣
 A – Virtual Reality🔟

1  A – Google Lens1️⃣
1  A – Gaming & training2️⃣
1  A – AR + VR + AI3️⃣
1  C – Meta4️⃣
1  A – Assistance5️⃣
1  A – ChatGPT6️⃣
1  A – DALL·E7️⃣
1  B – AI & data8️⃣
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1  A – Analysis9️⃣
2  A – Internet servers0️⃣
2  B – Protection1️⃣
2  A – Phishing2️⃣
2  B – Data theft3️⃣
2  B – Harmful software4️⃣
2  B – Encrypt & ransom5️⃣
2  B – Network security6️⃣
2  A – Remove malware7️⃣
2  B – Strong password8️⃣
2  B – Two-level security9️⃣
3  B – Crime unit0️⃣
3  C – 19301️⃣
3  B – Digital crime2️⃣
3  C – India3️⃣
3  A – Harassment4️⃣
3  B – Data protection5️⃣
3  B – 2 December6️⃣
3  A – February7️⃣
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3  A – Digital empowerment8️⃣
3  B – Responsible AI9️⃣
4  A – AI & Cyber0️⃣

 ✅Answer Key with Brief Explanation (1–100)
 B – Machine intelligence1️⃣
 D – Manual work2️⃣
 B – Learning from data3️⃣
 B – AI subset4️⃣
 B – Neural network5️⃣
 B – Chatbot6️⃣
 B – NLP + ML7️⃣
 B – Language processing8️⃣
 B – Augmented Reality9️⃣

1  A – Virtual Reality0️⃣
1  A – AR example1️⃣
1  A – Training/gaming2️⃣
1  A – Mixed tech3️⃣
1  C – Meta4️⃣
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1  A – Assistance5️⃣
1  A – AI tool6️⃣
1  A – Image AI7️⃣
1  B – Future skill8️⃣
1  A – Data analysis9️⃣
2  A – Cloud0️⃣
2  B – Protection1️⃣
2  A – Phishing2️⃣
2  B – Data theft3️⃣
2  B – Harmful software4️⃣
2  B – Encrypt & ransom5️⃣
2  B – Firewall6️⃣
2  A – Antivirus7️⃣
2  B – Strong password8️⃣
2  B – 2 level9️⃣
3  B – Crime unit0️⃣
3  C – 19301️⃣
3  B – Cyber law2️⃣
3  C – India3️⃣
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3  A – Online harassment4️⃣
3  B – Privacy5️⃣
3  B – 2 Dec6️⃣
3  A – February7️⃣
3  A – Digital India8️⃣
3  B – Ethical AI9️⃣
4  A – AI & Cyber0️⃣
4  A – Robotics + AI1️⃣
4  B – Reduce effort2️⃣
4  B – Industry 4.03️⃣
4  A – Connected devices4️⃣
4  A – IoT5️⃣
4  A – Smart farming6️⃣
4  A – Vision7️⃣
4  A – Image analysis8️⃣
4  A – Alexa9️⃣
5  A – Data scientist0️⃣
5  B – Responsible AI1️⃣
5  A – Data bias2️⃣
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5  B – Explain decisions3️⃣
5  B – Safe practices4️⃣
5  B – Human manipulation5️⃣
5  B – Identity theft6️⃣
5  B – Crime reporting7️⃣
5  B – Secure communication8️⃣
5  A – Encryption9️⃣
6  B – Decryption0️⃣
6  B – Zero trust1️⃣
6  A – Investigation2️⃣
6  B – Online trace3️⃣
6  A – Recommendation4️⃣
6  B – Verify news5️⃣
6  A – Fake media6️⃣
6  B – Reduce crime7️⃣
6  A – Personalized learning8️⃣
6  A – Smart city9️⃣
7  A – Automation0️⃣
7  B – Terrorism1️⃣
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7  B – Privacy2️⃣
7  A – Banking3️⃣
7  A – High power4️⃣
7  A – Blockchain5️⃣
7  B – AI policy6️⃣
7  B – Digital gap7️⃣
7  B – Safety8️⃣
7  A – Healthcare AI9️⃣
8  A – Skill India0️⃣
8  A – Cyber portal1️⃣
8  A – Translate AI2️⃣
8  A – Metaverse use3️⃣
8  B – Ethics4️⃣
8  A – Chatbot5️⃣
8  A – Authentication6️⃣
8  A – CIA triad7️⃣
8  A – Siri8️⃣
8  A – New jobs9️⃣
9  A – October0️⃣
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9  A – Autonomous AI1️⃣
9  B – Recovery2️⃣
9  A – Content AI3️⃣
9  A – Risk assessment4️⃣
9  A – Lifelong learning5️⃣
9  A – Voice to text6️⃣
9  B – Awareness7️⃣
9  B – Digital ethics8️⃣
9  A – Prediction9️⃣
10  A – Safe digital future0️⃣
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 ANSWER KEY WITH BRIEF EXPLANATION (1 to 100)✅
 B – Vacuum tubes used in first generation1️⃣
 C – Second generation started around 19562️⃣
 C – IC used in third generation3️⃣
 B – Microprocessor defines 4th gen4️⃣
 B – AI is base of 5th gen5️⃣
 B – Charles Babbage proposed computer6️⃣
 C – ENIAC was digital7️⃣
 B – Analytical Engine by Babbage8️⃣
 B – High electricity consumption9️⃣
 C – Data processing need🔟

1  B – CPU full form1️⃣
1  C – CPU controls all operations2️⃣
1  C – Keyboard is input3️⃣
1  C – Printer gives output4️⃣
1  B – RAM is temporary5️⃣
1  C – Hard disk stores data6️⃣
1  B – Weather & research7️⃣
1  C – Tablet is handheld8️⃣
1  C – Scanner digitizes paper9️⃣
2  B – UPS gives backup0️⃣
2  B – Physical parts1️⃣
2  C – Windows is software2️⃣
2  C – OS controls system3️⃣
2  B – User oriented tasks4️⃣
2  C – Linux is OS5️⃣
2  A – Firmware in ROM6️⃣
2  C – Source code available7️⃣
2  A – Antivirus utility8️⃣
2  B – Converts language9️⃣
3  B – Needs hardware0️⃣
3  B – Local Area Network1️⃣
3  D – Global level2️⃣
3  B – Data packets3️⃣
3  B – Cable TV4️⃣
3  C – Optical fiber fastest5️⃣
3  B – Signal conversion6️⃣
3  B – Wireless tech7️⃣
3  B – Short distance8️⃣
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3  B – Connects devices9️⃣
4  C – Exchange of info0️⃣
4  B – Artificial Intelligence1️⃣
4  B – AI based2️⃣
4  C – Access anywhere3️⃣
4  B – Crypto use4️⃣
4  C – Launched in 20155️⃣
4  B – High speed network6️⃣
4  B – Internet of Things7️⃣
4  B – Data protection8️⃣
4  B – Banking payment9️⃣
5  B – Protect environment0️⃣
5  B – Starting process1️⃣
5  B – Restart2️⃣
5  B – Mutual waiting3️⃣
5  C – Voltage protection4️⃣
5  C – Uninterruptible power5️⃣
5  B – Backup power6️⃣
5  C – Processing7️⃣
5  C – ALU, CU, Registers8️⃣
5  B – Calculations9️⃣
6  C – Controls instructions0️⃣
6  C – Binary1️⃣
6  B – High level language2️⃣
6  C – 0 & 13️⃣
6  B – Low level4️⃣
6  B – Assembly to machine5️⃣
6  A – HLL translation6️⃣
6  A – Line by line7️⃣
6  B – System software8️⃣
6  B – User work9️⃣
7  C – Application0️⃣
7  A – ARPANET1️⃣
7  C – USA2️⃣
7  A – World Wide Web3️⃣
7  B – Tim Berners-Lee4️⃣
7  B – Packets5️⃣
7  A – Device identity6️⃣
7  A – Internet provider7️⃣
7  B – Communication8️⃣
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7  B – Google9️⃣
8  A – Resource locator0️⃣
8  A – Aadhaar based1️⃣
8  C – Biometric2️⃣
8  B – Banking app3️⃣
8  A – Unified Payment4️⃣
8  A – Online fraud5️⃣
8  B – Security6️⃣
8  A – App interaction7️⃣
8  A – Cloud storage8️⃣
8  B – Future tech9️⃣
9  B – Protection0️⃣
9  B – Hardware design1️⃣
9  B – Same memory2️⃣
9  B – Speed increase3️⃣
9  C – Inside CPU4️⃣
9  B – Binary digit5️⃣
9  B – 8 bits6️⃣
9  B – Spreadsheet7️⃣
9  B – Info processing8️⃣
9  C – Presentation9️⃣
10  B – Database tool0️⃣

 ANSWER KEY (101–200) –  Operating System✅
101 C, 102 B, 103 A, 104 C, 105 C,
106 B, 107 B, 108 B, 109 C, 110 B,
111 B, 112 A, 113 A, 114 B, 115 B

116 A, 117 B, 118 A, 119 A, 120 B,
121 A, 122 B, 123 B, 124 A, 125 C,
126 B, 127 A, 128 B, 129 B, 130 B

131 C, 132 B, 133 A, 134 A, 135 B,
136 C, 137 B, 138 B, 139 B, 140 B,
141 B, 142 B, 143 B, 144 B, 145 A

146 B, 147 B, 148 A, 149 A, 150 D,
151 D, 152 B, 153 B, 154 A, 155 B,
156 B, 157 D, 158 A, 159 A, 160 A,
161 D, 162 A, 163 A, 164 D, 165 A,
166 A, 167 B, 168 D, 169 D, 170 B

171 A, 172 B, 173 A, 174 B, 175 B,
176 A, 177 A, 178 A, 179 A, 180 D,
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181 D, 182 A, 183 A, 184 B, 185 D,
186 A, 187 A, 188 D, 189 A, 190 D,
191 D, 192 D, 193 D, 194 D, 195 D,
196 D, 197 D, 198 B, 199 D, 200 A
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 LibreOffice Writer – 100 Questions📝
(60 MCQs + 40 True/False)

 PART–A: MCQs (1–60)🔹

 Basic Introduction & Interface🔸

Q1. LibreOffice Writer  क्या है?
What is LibreOffice Writer?
A) Spreadsheet software
B) Presentation software
C) Word processing software
D) Database software

Q2. LibreOffice     किस प्रकार का सॉफ्टवेयर है?
LibreOffice is a type of?
A) Proprietary
B) Open source
C) Trialware
D) Paid software



 MARATHON CLASS FOR CCC EXAM & OTHER                                                                                                                YORHELP EDUCATION

Q3. LibreOffice Writer      में नई फाइल बनाने की shortcut key  क्या है?
Shortcut key to create new file is?
A) Ctrl+S
B) Ctrl+N
C) Ctrl+O
D) Ctrl+P

Q4. Writer  में document save   करने की shortcut key है?
Shortcut key to save document is?
A) Ctrl+P
B) Ctrl+N
C) Ctrl+S
D) Ctrl+E

Q5. LibreOffice Writer  की default file extension  क्या है?
Default file extension of Writer is?
A) .doc
B) .docx
C) .odt
D) .pdf
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 Formatting & Editing🔸

Q6. Text  को Bold   करने की shortcut key  क्या है?
Shortcut for Bold text is?
A) Ctrl+I
B) Ctrl+U
C) Ctrl+B
D) Ctrl+T

Q7. Paragraph alignment   के लिए कौन-    सा विकल्प नहीं  है?
Which is NOT a paragraph alignment?
A) Left
B) Right
C) Center
D) Diagonal

Q8. Line spacing      बदलने का विकल्प कहाँ मिलता है?
Line spacing option is found in?
A) Insert Menu
B) Format Menu
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C) Tools Menu
D) View Menu

Q9. Text  को uppercase     में बदलने के लिए कौन-  सा menu   उपयोग होता है?
Menu used to change text case is?
A) Edit
B) View
C) Format
D) Tools

Q10. Cut, Copy, Paste  किस menu   में होते हैं?
Cut, Copy, Paste are in which menu?
A) File
B) Edit
C) View
D) Tools

 Page Setup & Layout🔸

Q11. Page Orientation    बदलने के लिए कौन-   सा विकल्प है?
Option to change page orientation is?
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A) Page Style
B) Paragraph Style
C) Character Style
D) Table Style

Q12. Portrait  और Landscape  क्या हैं?
Portrait and Landscape are?
A) Font styles
B) Page orientations
C) Paper sizes
D) Margins

Q13. Page margin      सेट करने का विकल्प कहाँ है?
Page margin option is in?
A) Insert
B) Format → Page Style
C) Tools
D) View

Q14. Page number insert    करने का विकल्प है?
Option to insert page number is?
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A) Edit → Page
B) Insert → Page Number
C) Tools → Page
D) View → Page

Q15. Header  और Footer    किसलिए उपयोग होते हैं?
Header and Footer are used for?
A) Images
B) Repeated text on pages
C) Tables
D) Charts

 Tables, Images & Objects🔸

Q16. Table insert   करने की shortcut key  क्या है?
Shortcut key to insert table is?
A) Ctrl+T
B) Ctrl+F12
C) Ctrl+Shift+T
D) Alt+T
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Q17. Table  में row     जोड़ने का विकल्प कहाँ है?
Option to add row is in?
A) Insert Menu
B) Table Menu
C) Tools Menu
D) View Menu

Q18. Image insert    करने के लिए कौन-  सा menu है?
Menu used to insert image is?
A) File
B) Insert
C) Format
D) Tools

Q19. Image  को text   के साथ adjust     करने को क्या कहते हैं?
Adjusting image with text is called?
A) Cropping
B) Anchoring
C) Wrapping
D) Grouping
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Q20. ClipArt insert      करने का विकल्प किसमें होता है?
ClipArt option is found in?
A) Insert
B) View
C) Tools
D) Format

 Styles, Tools & Utilities🔸

Q21. Styles and Formatting   खोलने की shortcut key?
Shortcut for Styles is?
A) F5
B) F7
C) F11
D) F12

Q22. Spell Check  की shortcut key  क्या है?
Shortcut for Spell Check is?
A) F2
B) F5
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C) F7
D) F9

Q23. Thesaurus      का उपयोग किस लिए होता है?
Thesaurus is used for?
A) Grammar
B) Synonyms
C) Formatting
D) Printing

Q24. Find & Replace  की shortcut key?
Shortcut for Find & Replace is?
A) Ctrl+F
B) Ctrl+H
C) Ctrl+R
D) Ctrl+L

Q25. Track Changes      का उपयोग किस लिए होता है?
Track Changes is used for?
A) Printing
B) Editing history



 MARATHON CLASS FOR CCC EXAM & OTHER                                                                                                                YORHELP EDUCATION

C) Saving file
D) Page setup

 Advanced & Output🔸

Q26. Writer document  को PDF  में export    करने का विकल्प है?
Option to export PDF is?
A) Save As
B) Export as PDF
C) Print
D) Tools

Q27. Mail Merge      का उपयोग किस लिए होता है?
Mail Merge is used for?
A) Emails
B) Bulk letters
C) Tables
D) Charts

Q28. AutoCorrect      का उपयोग किस लिए होता है?
AutoCorrect is used for?
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A) Image correction
B) Auto spelling correction
C) Grammar only
D) Formatting

Q29. Writer  में Index    बनाने का उपयोग किसलिए?
Index is used for?
A) Design
B) Reference
C) Printing
D) Alignment

Q30. Writer  में Comment   जोड़ने का उपयोग?
Adding comment is used for?
A) Decoration
B) Review
C) Print
D) Save
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 File Handling & Printing🔸

Q31. Print Preview  का उपयोग?
Print Preview is used to?
A) Edit
B) View before printing
C) Save
D) Format

Q32. Printing  की shortcut key?
Shortcut key for print is?
A) Ctrl+S
B) Ctrl+P
C) Ctrl+N
D) Ctrl+O

Q33. Document  को password      से सुरक्षित करने का विकल्प है?
Password protection option is in?
A) Save As
B) Tools
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C) View
D) Insert

Q34. Writer  में Undo  की shortcut key?
Shortcut for Undo is?
A) Ctrl+Z
B) Ctrl+Y
C) Ctrl+U
D) Ctrl+X

Q35. Redo  की shortcut key  क्या है?
Shortcut for Redo is?
A) Ctrl+Z
B) Ctrl+R
C) Ctrl+Y
D) Ctrl+X

 Miscellaneous🔸

Q36. Writer  में Columns  का उपयोग?
Columns are used for?
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A) Tables
B) Newspaper layout
C) Images
D) Charts

Q37. Footnote  का उपयोग?
Footnote is used for?
A) Header
B) Footer
C) Reference note
D) Title

Q38. Writer  में Bookmark  का उपयोग?
Bookmark is used to?
A) Mark position
B) Print
C) Save
D) Format

Q39. Writer  में Hyperlink  का उपयोग?
Hyperlink is used to?
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A) Insert image
B) Link web/page
C) Format text
D) Print

Q40. LibreOffice Writer  किस OS   पर चलता है?
LibreOffice Writer runs on?
A) Windows
B) Linux
C) macOS
D) All of these

 Extra MCQs (41–60)🔸

Q41. Writer  में Default font    क्या होता है (  आमतौर पर)?
Default font usually is?
A) Arial
B) Times New Roman
C) Liberation Serif
D) Calibri
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Q42. Text justify   करने का अर्थ?
Meaning of justify text?
A) Left only
B) Right only
C) Equal spacing both sides
D) Center

Q43. Page Break insert   करने की shortcut key?
Shortcut for page break is?
A) Ctrl+Enter
B) Ctrl+Shift+Enter
C) Alt+Enter
D) Shift+Enter

Q44. Writer  में Zoom  का उपयोग?
Zoom is used to?
A) Increase font size
B) View size change
C) Print
D) Save
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Q45. Navigator   खोलने की shortcut key?
Shortcut for Navigator is?
A) F3
B) F5
C) F9
D) F11

Q46. Text background color    को क्या कहते हैं?
Text background color is called?
A) Highlight
B) Shade
C) Border
D) Fill

Q47. Writer  में AutoSave सुविधा?
AutoSave is used for?
A) Manual save
B) Automatic save
C) Print
D) Format



 MARATHON CLASS FOR CCC EXAM & OTHER                                                                                                                YORHELP EDUCATION

Q48. Writer  में Word Count  किस menu  में है?
Word Count is found in?
A) File
B) Tools
C) View
D) Edit

Q49. Text selection   के लिए Ctrl+A  का उपयोग?
Ctrl+A is used for?
A) Copy
B) Select all
C) Cut
D) Paste

Q50. LibreOffice Writer    का उपयोग मुख्यतः किसलिए?
Writer is mainly used for?
A) Calculations
B) Documents
C) Presentations
D) Databases
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Q51–Q60 (Revision MCQs – exam oriented)
51) Spell check key – F7
52) Style shortcut – F11
53) Header insert – Insert menu
54) Footer insert – Insert menu
55) Image resize – Drag handles
56) Wrap text option – Format
57) Default page size – A4
58) Superscript shortcut – Ctrl+Shift+P
59) Subscript shortcut – Ctrl+Shift+B
60) LibreOffice alternative of MS Word – Writer

 PART–B: True / False (61–100)🔹

61.LibreOffice Writer  एक open source software  है। (True)

62.Writer  में .docx format open   नहीं  होता। (False)

63.Spell check F7    से होता है। (True)

64.Header  हर page     पर दिखाई देता है। (True)

65.Writer  के वल Windows    पर चलता है। (False)
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66.Writer  में table insert     किया जा सकता है। (True)

67.Ctrl+B italic     के लिए होता है। (False)

68.Ctrl+I italic     के लिए होता है। (True)

69.Writer  में image insert   संभव है। (True)

70.Page number footer     में डाला जाता है। (True)

71.Writer  में PDF export    संभव नहीं  है। (False)

72.Styles formatting     को आसान बनाते हैं। (True)

73.LibreOffice Writer paid software  है। (False)

74.Mail Merge bulk letters     के लिए होता है। (True)

75.Writer  में Track Changes   सुविधा है। (True)

76.Writer  में Thesaurus   उपलब्ध है। (True)

77.Word count Tools menu    में होता है। (True)

78.Writer  में password protection   नहीं  है। (False)

79.Writer  में hyperlink add     किया जा सकता है। (True)

80.Writer GUI  आधारित software  है। (True)

81.Writer  में footnote     दिया जा सकता है। (True)
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82.Ctrl+P print     के लिए होता है। (True)

83.Writer  में column layout   संभव है। (True)

84.Writer  के वल English language support   करता है। (False)

85.AutoCorrect spelling   सुधारता है। (True)

86.Writer  में zoom option   होता है। (True)

87.Writer  में charts insert   नहीं  होते। (False)

88.Undo shortcut Ctrl+Z  है। (True)

89.Redo shortcut Ctrl+Y  है। (True)

90.Writer database software  है। (False)

91.LibreOffice Writer MS Word  का alternative  है। (True)

92.Writer  में comments add     किए जा सकते हैं। (True)

93.Writer  में clipboard   होता है। (True)

94.Writer offline software  है। (True)

95.Writer  में image wrap   संभव है। (True)

96.Writer  में page break insert   नहीं  होता। (False)

97.Writer  में default page size A4   होती है। (True)
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98.Writer  में superscript/subscript   संभव है। (True)

99.Writer system software  है। (False)

100.Writer word processing software  है। (True)
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	🔹 True / False Questions (491–500)

	✅ Answer Key with Brief Explanation (PART–1)
	🔸 MCQs (401–500)
	🔸 True / False
	🔸 True / False
	Topics Covered
	Q1. Digital Financial Tools का अर्थ क्या है?
	Q2. Biometric authentication का अर्थ है?
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	Q23. Cyber security का अर्थ क्या है?
	Q24. Online fraud का उदाहरण कौन सा है?
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	Q26. OTP का उपयोग क्यों किया जाता है?
	Q27. Digital Wallet का उदाहरण कौन सा है?
	Q28. Mobile Banking का उपयोग किस device से होता है?
	Q29. KYC का पूरा नाम क्या है?
	Q30. KYC का उद्देश्य क्या है?
	Q31. Digital payment में PIN का कार्य?
	Q32. QR code का उपयोग किस लिए किया जाता है?
	Q33. Contactless payment किस तकनीक पर आधारित है?
	Q34. Digital banking का एक नुकसान?
	Q35. Two-factor authentication में क्या शामिल होता है?
	Q36. Online banking में strong password कैसा होना चाहिए?
	Q37. Bank fraud की रिपोर्ट कहाँ करें?
	Q38. NPCI का पूरा नाम क्या है?
	Q39. NPCI का कार्य क्या है?
	Q40. Digital India initiative का एक उद्देश्य?
	Q41. Online transaction में “Fail” होने पर क्या करना चाहिए?
	Q42. Bank कभी भी क्या नहीं पूछता?
	Q43. Secure website की पहचान कैसे करें?
	Q44. Digital receipt का लाभ?
	Q45. Cashless payment का लाभ?
	Q46. Online transaction में minimum risk कैसे रखें?
	Q47. Digital banking में “Logout” क्यों जरूरी है?
	Q48. SMS alert का उपयोग?
	Q49. Online payment में “Refund” का अर्थ?
	Q50. Financial literacy का अर्थ?
	🔹 True / False (91–95)
	1. Q51. AEPS सेवा का लाभ किसे अधिक होता है?
	Q52. AEPS transaction के लिए कौन सी जानकारी आवश्यक नहीं है?
	Q53. BHIM App किस payment system पर आधारित है?
	Q54. UPI transaction की सीमा (limit) किस पर निर्भर करती है?
	Q55. UPI में “Collect Request” का अर्थ क्या है?
	Q56. Digital Banking में “Net Banking” का उपयोग किसके लिए होता है?
	Q57. E-Banking में “Session Timeout” क्यों होता है?
	Q58. Online transaction में “Chargeback” क्या है?
	Q59. NEFT transaction कब settle होता है?
	Q60. RTGS transaction के लिए सामान्यतः न्यूनतम राशि कितनी होती है?
	Q61. IMPS transaction के लिए क्या आवश्यक है?
	Q62. Digital Wallet में पैसा कैसे जोड़ा जाता है?
	Q63. Prepaid Payment Instrument (PPI) का उदाहरण कौन सा है?
	Q64. QR code based payment का मुख्य लाभ?
	Q65. Contactless card payment में PIN कब जरूरी होता है?
	Q66. Cyber attack का उद्देश्य क्या होता है?
	Q67. Malware का अर्थ क्या है?
	Q68. Ransomware क्या करता है?
	Q69. Online banking में public Wi-Fi का उपयोग क्यों नहीं करना चाहिए?
	Q70. “Man-in-the-Middle” attack क्या है?
	Q71. Payment Gateway का कार्य क्या है?
	Q72. Online shopping में “Secure Payment” का संकेत?
	Q73. Digital transaction में “Failed but debited” का क्या अर्थ है?
	Q74. Failed transaction में पैसा सामान्यतः कितने दिनों में वापस आता है?
	Q75. Cyber crime helpline number क्या है?
	Q76. AEPS transaction कहाँ किया जा सकता है?
	Q77. Digital banking में “Auto-debit” का अर्थ?
	Q78. Online transaction का record कहाँ मिलता है?
	Q79. Virtual Debit Card का उपयोग?
	Q80. Tokenization का उपयोग किस लिए किया जाता है?
	Q81. Digital payment system को regulate कौन करता है?
	Q82. RBI का पूरा नाम क्या है?
	Q83. Cashless economy का लाभ?
	Q84. Digital payment में “Reversal” का अर्थ?
	Q85. Banking fraud से बचने का सही तरीका?
	Q86. Digital literacy का अर्थ?
	Q87. Online banking में “Beneficiary” कौन होता है?
	Q88. IMPS में पैसा कितनी देर में transfer होता है?
	Q89. Digital transaction के लिए सबसे सुरक्षित तरीका?
	Q90. Financial fraud होने पर सबसे पहले क्या करें?
	Q91. Micro-ATM का उपयोग किससे संबंधित है?
	Q92. Offline digital payment का उदाहरण?
	Q93. Sound-based UPI का उपयोग किस लिए किया गया?
	Q94. CBDC का पूरा नाम क्या है?
	Q95. Digital Rupee किसके द्वारा जारी की जाती है?
	Q96. Biometric authentication का एक जोखिम?
	Q97. Online banking में antivirus का उपयोग क्यों जरूरी है?
	Q98. Digital payment में “Settlement” का अर्थ?
	Q99. UPI PIN भूल जाने पर क्या करना चाहिए?
	Q100. Digital Financial Tools का सबसे बड़ा लाभ?

	🔹 True / False Questions (96–105)

	✅ Answer Key with Brief Explanation (PART–1)
	✅ Answer Key with Brief Explanation (PART–2)
	Q2. AI का उपयोग किस क्षेत्र में नहीं होता?
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